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This	help	file	contains	fundamental	and	advanced	concepts	necessary	for
using	NI	power	supplies	and	SMUs	and	the	NI-DCPower	instrument
driver.	In	addition	to	device-specific	information,	this	help	file	contains
getting	started	steps	for	creating	an	application	using	LabVIEW,
LabWindows™/CVI™,	and	Microsoft	Visual	Basic	and	includes	LabVIEW
and	C/CVI/VB	programming	references.
National	Instruments	power	supplies	and	SMUs	include	the	following
devices:

Device Details
NI	PXI-
4110

Three	single-quadrant	DC	power	supply	channels

NI	PXI-
4130

Two	output	channels:	Channel	0	is	a	single-quadrant	power
supply;	
Channel	1,	the	SMU	channel,	is	a	four-quadrant,	bipolar	power
source-measure	unit

For	more	information	about	this	help	file,	refer	to	the	following	topics:
Using	Help
Related	Documentation
Glossary
Important	Information
Technical	Support	and	Professional	Services
To	comment	on	this	documentation,	refer	to	the	National	Instruments
Web	site.
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Related	Documentation
Most	NI	power	supply	and	SMU	manuals	also	are	available	as	PDFs.
You	must	have	Adobe	Reader	with	Search	and	Accessibility	5.0.5	or	later
installed	to	view	the	PDFs.	Refer	to	the	Adobe	Systems	Incorporated
Web	site	at	www.adobe.com	to	download	Adobe	Reader.	Refer	to	the
National	Instruments	Product	Manuals	Library	at	ni.com/manuals	for
updated	documentation	resources.
The	following	documents	contain	information	that	you	may	find	helpful	as
you	use	this	help	file.

NI-DCPower	Readme
NI	DC	Power	Supplies	and	SMUs	Getting	Started	Guide	(PDF)
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NI	PXI-4110
NI	PXI-4110	Specifications	(PDF)
NI	PXI-4110	Calibration	Procedure	(PDF)
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NI	PXI-4130	Calibration	Procedure	(PDF)
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Conventions
This	help	file	uses	the	following	formatting	and	typographical
conventions:

<	> Angle	brackets	that	contain	numbers	separated	by	an
ellipsis	represent	a	range	of	values	associated	with	a	bit	or
signal	name—for	example,	AO	<0..3>.

[	] Square	brackets	enclose	optional	items—for	example,
[response].

» The	»	symbol	leads	you	through	nested	menu	items	and
dialog	box	options	to	a	final	action.	The	sequence
File»Page	Setup»Options	directs	you	to	pull	down	the	File
menu,	select	the	Page	Setup	item,	and	select	Options	from
the	last	dialog	box.
This	icon	denotes	a	tip,	which	alerts	you	to	advisory
information.
This	icon	denotes	a	note,	which	alerts	you	to	important
information.
This	icon	denotes	a	caution,	which	advises	you	of
precautions	to	take	to	avoid	injury,	data	loss,	or	a	system
crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in
the	software,	such	as	menu	items	and	dialog	box	options.
Bold	text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

dark	red Text	in	this	color	denotes	a	caution.
green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,

help	file,	or	Web	address.
italic Italic	text	denotes	variables,	emphasis,	cross–references,	or

an	introduction	to	a	key	concept.	Italic	text	also	denotes	text
that	is	a	placeholder	for	a	word	or	value	that	you	must
supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should
enter	from	the	keyboard,	sections	of	code,	programming
examples,	and	syntax	examples.	This	font	is	also	used	for



the	proper	names	of	disk	drives,	paths,	directories,
programs,	subprograms,	subroutines,	device	names,
functions,	operations,	variables,	filenames,	and	extensions.

monospace
bold

Bold	text	in	this	font	denotes	the	messages	and	responses
that	the	computer	automatically	prints	to	the	screen.	This
font	also	emphasizes	lines	of	code	that	are	different	from	the
other	examples.

monospace
italic

Italic	text	in	this	font	denotes	text	that	is	a	placeholder	for	a
word	or	value	that	you	must	supply.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the
help	file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,
Traditional	Chinese,	Japanese,	and	Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both	search	terms.	You
do	not	need	to	specify	this	operator	unless	you	are	using	nested
expressions.
OR—Returns	topics	that	contain	either	the	first	or	second	term.
NOT—Returns	topics	that	contain	the	first	term	without	the	second
term.
NEAR—Returns	topics	that	contain	both	terms	within	eight	words
of	each	other.



Search	Options

Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:
Search	previous	results—Narrows	the	results	from	a	search	that
returned	too	many	topics.	You	must	remove	the	checkmark	from
this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.



Fundamentals
This	book	contains	information	on	the	nomenclature	and	concepts	related
to	NI	power	supplies	and	SMUs,	explaining	the	specific	terms	used	to
describe	device	performance.	This	book	is	divided	into	the	following
topics:

Accuracy
Compliance
Constant	Current	Mode
Constant	Voltage	Mode
Cabling	and	Current-Resistance	Loss
Line	Regulation
Load	Considerations
Load	Regulation
Local	and	Remote	Sense
Measurements
Measuring	Resistance
Noise
Ranges
Resolution
Rise	Time
Sinking	and	Sourcing



Accuracy
A	measurement	or	output	level	on	a	power	supply	or	SMU	can	differ	from
the	actual	or	requested	value.	Accuracy	represents	the	uncertainty	of	a
given	measurement	or	output	level	and	can	be	defined	in	terms	of	the
deviation	from	an	ideal	transfer	function,	as	follows:
y	=	mx	+	b

where
m	is	the	ideal	gain	of	the	system
x	is	the	input	to	the	system
b	is	the	offset	of	the	system

Applying	this	example	to	a	power	supply	or	SMU	signal	measurement,	y
is	the	reading	obtained	from	the	device	with	x	as	the	input,	and	b	is	an
offset	error	that	you	may	be	able	to	null	before	the	measurement	is
performed.	If	m	is	1	and	b	is	0,	the	output	measurement	is	equal	to	the
input.	If	m	is	1.0001,	then	the	error	from	the	ideal	is	0.01%.
Parts	per	million	(ppm)	is	another	common	unit	used	to	represent
accuracy.	The	following	table	shows	ppm	to	percent	conversions.

ppm Percent
1 0.0001
10 0.001
100 0.01
1,000 0.1
10,000 1

Most	high-resolution,	high-accuracy	power	supplies	and	SMUs	describe
accuracy	as	a	combination	of	an	offset	error	and	a	gain	error.	These	two
error	terms	are	added	to	determine	the	total	accuracy	specification	for	a
given	measurement.	NI	power	supplies	and	SMUs	typically	specify	offset
errors	with	absolute	units	(for	example,	mV	or	μA),	while	gain	errors	are
specified	as	a	percentage	of	the	reading	or	the	requested	value.
The	following	example	illustrates	how	to	calculate	the	accuracy	of	a	1	mA
current	measurement	in	the	2	mA	range	of	an	SMU	with	an	accuracy
specification	of	0.03%	+	0.4	μA:



Accuracy	=		(0.0003	×	1	mA)	+	0.4	μA	=	0.7	μA
Therefore,	the	reading	of	1	mA	should	be	within	±0.7	μA	of	the	actual
current.

Note		Temperature	can	have	a	significant	impact	on	the	accuracy
of	a	power	supply	or	SMU	and	is	a	common	problem	for	precision
measurements.	The	temperature	coefficient,	or	tempco,
expresses	the	error	caused	by	temperature.	Errors	are	calculated
as	±(%	of	reading	+	offset	range)/ºC	and	are	added	to	the
accuracy	specification	when	operating	outside	the	power	supply	or
SMU	rated	accuracy	temperature	range	(usually	23±10°C	or
23±5°C).



Compliance
For	power	supplies	and	SMUs,	a	channel	is	operating	in	compliance
when	it	cannot	reach	the	requested	output	level	because	the
programmed	limit	has	been	reached.
The	following	two	figures	help	to	graphically	describe	compliance	for	a
specific	application:	the	output	function	is	set	to
NIDCPOWER_VAL_DC_VOLTAGE	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Voltage	using	the
niDCPower	Configure	Output	Function	VI	with	a	1.5	mA	current	limit.

	
Because	the	20	kΩ	load	resistance	in	the	figure	on	the	left	never	allows
the	output	current	to	exceed	the	current	limit	of	1.5	mA	(given	a	maximum
requested	voltage	of	20	V),	the	source	driving	this	load	never	enters
compliance.	This	circuit	always	operates	in	Constant	Voltage	mode.
In	contrast,	the	10	kΩ	load	resistance	in	the	figure	on	the	right	causes	a
higher	current	draw.	The	output	voltage	of	the	power	supply	or	SMU
operates	in	Constant	Voltage	mode	up	to	15	V.	Above	the	15	V	requested
output,	the	load	draws	1.5	mA,	thus	the	source	operates	in	Constant
Current	mode	at	the	current	limit.	While	operating	at	the	current	limit,	the
channel	is	said	to	be	in	compliance.	In	this	case,	although	the	requested
output	voltage	is	>	15	V,	the	actual	voltage	does	not	exceed	15	V
because	the	current	limit	has	been	reached.
You	can	query	a	channel	to	determine	if	it	is	in	compliance	using	the
niDCPower	Query	in	Compliance	VI	or	the	niDCPower_QueryInCompliance
function.

Note			The	NI-DCPower	Soft	Front	Panel	displays	Cmpl	when	a
channel	is	in	compliance.
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Cabling	and	Current-Resistance	Loss
Current-resistance	loss	is	introduced	by	the	cabling	wires	that	connect
the	power	supply	or	SMU	to	the	load	terminals.	The	voltage	drop	due	to
current-resistance	loss	is	determined	by	the	resistance	of	the	cabling	wire
(a	property	of	the	wire	gauge	and	length)	and	the	amount	of	current
flowing	through	the	wire.	Devices	with	remote	sense	capabilities	can
compensate	for	current-resistance	loss	by	measuring	the	voltage	across
the	load	terminals	with	a	second	set	of	leads	that	do	not	carry	a
significant	current.
To	minimize	voltage	drop	caused	by	cabling,	keep	each	wire	pair	as	short
as	possible	and	use	the	thickest	wire	gauge	appropriate	for	your
application.	The	lower	the	American	Wire	Gauge	(AWG)	rating,	the
thicker	the	wire.	NI	recommends	18	AWG	or	lower.
To	reduce	noise	picked	up	by	cabling	connecting	a	power	supply	or	SMU
to	a	load,	twist	each	wire	pair.	Refer	to	the	following	table	to	determine
the	wire	gauge	appropriate	for	your	application.

Caution		Use	wire	that	is	thick	enough	to	avoid	overheating	if	the
output	current	from	the	power	supply	or	SMU	were	to	short	circuit.

AWG	Rating mΩ/m	(mΩ/ft)
10 3.3	(1.0)
12 5.2	(1.6)
14 8.3	(2.5)
16 13.2	(4.0)
18 21.0	(6.4)
20 33.5	(10.2)
22 52.8	(16.1)
24 84.3	(25.7)
26 133.9	(40.8)
28 212.9	(64.9)



Calculating	Maximum	Voltage	Drop
When	cabling	a	power	supply	or	SMU	to	a	constant	load,	be	sure	to
account	for	voltage	drop	in	your	application.	If	necessary,	adjust	the
output	voltage	of	the	device	or,	if	available,	use	remote	sensing.
Use	the	amount	of	current	flowing	through	the	cabling	wires	and	the
resistance	of	the	wires	to	calculate	the	total	voltage	drop	for	each	load,
as	shown	in	the	following	example:
Example
Operating	within	the	recommended	current	rating,	determine	the
maximum	voltage	drop	across	a	1	m,	16	AWG	wire	carrying	1	A:
V	=	I	×	R
V	=	1	A	×	(13.2	mΩ/m	×	1	m)
V	=	13.2	mV
As	illustrated	in	the	preceding	example,	a	1	m,	16	AWG	wire	carrying	1	A
results	in	a	voltage	drop	of	13.2	mV.

Note		When	calculating	voltage	drop	for	a	pair	of	wires,	multiply
the	voltage	drop	by	two.	Thus,	the	total	voltage	drop	for	a	pair	of
wires	in	the	previous	example	is	26.4	mV.	To	compensate	for	the
voltage	drop	across	the	wire	pair	and	ensure	the	correct	power	is
supplied	to	the	load,	increase	the	output	voltage	of	the	power
supply	by	26.4	mV,	or	if	available,	use	remote	sensing.



Cabling	for	Low-Level	Measurements
Low-level	measurements	require	tight	control	over	system	setup	and
cabling.	Long	cables	and	large	current	loops	degrade	source	and
measurement	quality	even	in	low-noise	environments.
To	maintain	measurement	quality,	always	limit	the	length	of	the	cables
involved	in	your	system	setup.	Also,	keep	the	current	return	path	as	close
as	possible	to	the	current	source	path	by	employing	twisted	pair	cabling.
To	reduce	the	susceptibility	of	low	currents	to	noise	and	other	unwanted
interfering	signals,	use	shielded	cables	(for	example,	coaxial	cable).
Connect	the	outer	conductor	to	the	common	or	ground	terminal	of	the
channel.



Related	Topics
Local	and	Remote	Sense



Constant	Current	Mode
An	output	channel	is	operating	in	Constant	Current	mode	when	either	a
load	attempts	to	draw	more	current	than	the	programmed	limit	and	the
output	function	is	set	to	NIDCPOWER_VAL_DC_VOLTAGE	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Voltage	using	the
niDCPower	Configure	Output	Function	VI,	or	when	the	voltage	across	the
load	is	less	than	the	voltage	limit	and	the	output	function	is	set	to
NIDCPOWER_VAL_DC_CURRENT	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Current	using	the
niDCPower	Configure	Output	Function	VI.
In	Constant	Current	mode,	the	current	flowing	through	the	output
terminals	is	held	constant	while	the	voltage	across	the	output	terminals
may	change	depending	on	loading	conditions.	The	output	channel
behaves	like	a	current	source	when	in	this	mode.

Note		Constant	Current	mode	is	synonymous	with	Current-
Controlled	mode.

To	determine	when	an	output	channel	is	operating	in	Constant	Current
mode,	use	the	status	indicators	on	the	front	panel	of	the	device,	the
niDCPower	Query	Output	State	VI,	or	the	niDCPower_QueryOutputState
function.
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Related	Topics
Constant	Voltage	Mode
Load	Considerations
Load	Regulation



Constant	Voltage	Mode
An	output	channel	is	operating	in	Constant	Voltage	mode	when	either	a
load	attempts	to	draw	less	current	than	the	current	limit	and	the	output
function	is	set	to	NIDCPOWER_VAL_DC_VOLTAGE	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Voltage	using	the
niDCPower	Configure	Output	Function	VI,	or	when	the	voltage	across	the
load	is	greater	than	the	voltage	limit	and	the	output	function	is	set	to
NIDCPOWER_VAL_DC_CURRENT	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Current	using	the
niDCPower	Configure	Output	Function	VI.
In	Constant	Voltage	mode,	the	voltage	across	the	output	terminals	is	held
constant	while	the	current	through	the	output	terminals	may	change
depending	on	loading	conditions.	The	output	channel	behaves	like	a
voltage	source	when	in	this	mode.

Note		Constant	Voltage	mode	is	synonymous	with	Voltage-
Controlled	mode.

To	determine	when	an	output	channel	is	operating	in	Constant	Voltage,
use	the	status	indicators	on	the	front	panel	of	the	device,	the
niDCPower	Query	Output	State	VI,	or	the	niDCPower_QueryOutputState
function.
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Constant	Current	Mode
Load	Considerations
Load	Regulation



Line	Regulation
Line	regulation	is	a	measure	of	the	ability	of	the	power	supply	or	SMU	to
maintain	the	output	voltage	given	changes	in	the	input	line	voltage.	Line
regulation	is	expressed	as	percent	of	change	in	the	output	voltage
relative	to	the	change	in	the	input	line	voltage.
For	NI	DC	power	supplies	and	SMUs,	the	line	regulation	specification
applies	to	the	auxiliary	power	input.



Load	Considerations
This	topic	contains	information	you	may	find	useful	as	you	connect
specific	types	of	loads	to	a	power	supply	or	SMU.



Capacitive	Loads
Generally,	a	power	supply	or	SMU	remains	stable	when	driving	a
capacitive	load.	Occasionally,	certain	capacitive	loads	can	cause	ringing
in	the	transient	response	of	the	device.	When	the	output	voltage	is
reprogrammed	while	capacitive	loads	are	present,	the	device	may
temporarily	move	into	Constant	Current	mode	or	unregulated	mode.
The	slew	rate	is	the	maximum	rate	of	change	of	the	output	voltage	as	a
function	of	time.	When	driving	a	capacitor,	the	slew	rate	is	limited	to	the
output	current	limit	divided	by	the	total	load	capacitance,	as	expressed	in
the	following	equation:

(ΔV/Δt)	=	(I/C)	
where ΔV	is	the	change	in	the	output	voltage

Δt	is	the	change	in	time
I	is	the	current	limit
C	is	the	total	capacitance	across	the	load

Series	resistance	or	lead	inductance	from	cabling	can	affect	the	stability
of	the	device.	In	some	situations,	it	might	be	necessary	to	increase	the
capacitive	load	or	locally	bypass	the	circuit	or	system	being	powered	to
stabilize	the	power	supply	or	SMU.



Inductive	Loads
In	Constant	Voltage	mode,	most	inductive	loads	remain	stable.
However,when	operating	in	Constant	Current	mode	in	higher	current
ranges,	increasing	output	capacitance	may	help	improve	stability.	You
can	select	the	output	capacitance	of	some	power	supplies	or	SMUs	using
the	niDCPower	Output	Capacitance	property	or	the
NIDCPOWER_ATTR_OUTPUT_CAPACITANCE	attribute.
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Pulse	Loads
Load	current	can	vary	between	a	minimum	and	a	maximum	value	in
some	applications.	In	the	case	of	a	varying	load,	or	pulse	load,	the
constant	current	circuit	of	the	power	supply	or	SMU	limits	the	output
current.	Occasionally,	a	peak	current	may	try	to	exceed	the	current	limit
and	cause	the	power	supply	or	SMU	to	temporarily	move	into	Constant
Current	mode	or	unregulated	mode.
To	avoid	pulse	loads	and	remain	within	the	power	supply	or	SMU	output
specifications,	use	the	niDCPower	Configure	Current	Limit	VI	or	the
niDCPower_ConfigureCurrentLimit	function	to	configure	the	current	limit	to
a	value	greater	than	the	expected	peak	current	of	the	load.	In	extreme
situations,	it	may	be	possible	to	parallel	connect	multiple	power	supply
channels	to	provide	higher	peak	currents.	SMU	output	channels	should
not	be	placed	in	parallel	because	SMUs	are	four	quadrant	devices,	and
some	combination	of	sourcing	and	sinking	occurs	if	the	output	voltages	of
the	channels	are	not	exactly	identical.
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Reverse	Current	Loads
Occasionally,	an	active	load	may	pass	a	reverse	current	to	the	power
supply	or	SMU.	To	avoid	reverse	current	loads,	use	a	bleed-off	load	to
preload	the	output	of	the	device.	Ideally,	a	bleed-off	load	should	draw	the
same	amount	of	current	from	the	device	that	an	active	load	may	pass	to
the	power	supply	or	SMU.

Caution			Power	supplies	not	designed	for	4-quadrant	operation
may	become	damaged	if	reverse	currents	are	applied	to	their
output	terminals.	Reverse	currents	can	cause	the	device	to	move
into	an	unregulated	mode	and	can	damage	the	device.	Refer	to	NI
PXI-4110	or	NI	PXI-4130	for	more	information	about	device
channel	capabilities.

Note		The	sum	of	the	bleed-off	load	current	and	the	current
supplied	to	the	load	must	be	less	than	the	maximum	current	of	the
device.



Related	Topics
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Load	Regulation
Load	regulation	is	a	measure	of	the	ability	of	an	output	channel	to	remain
constant	given	changes	in	the	load.	Depending	on	the	control	mode
enabled	on	the	output	channel,	the	load	regulation	specification	can	be
expressed	in	one	of	two	ways:

In	Constant	Voltage	mode,	variations	in	the	load	result	in	changes
in	the	output	current.	This	variation	is	expressed	as	a	percentage
of	output	voltage	range	per	amp	of	current	change,	and	is
synonymous	with	a	series	resistance.	When	using	local	sense	in
Constant	Voltage	mode,	the	load	regulation	specification	defines
how	close	the	output	series	resistance	is	to	0	Ω—the	series
resistance	of	an	ideal	voltage	source.
In	Constant	Current	mode,	variations	in	the	load	result	in	changes
to	the	voltage	across	the	load.	This	variation	is	expressed	as	a
percentage	of	change	in	the	output	current	range,	in	amps	per	volt,
and	is	synonymous	with	a	resistance	in	parallel	with	the	output
channel	terminals.	In	Constant	Current	mode,	the	load	regulation
specification	defines	how	close	the	output	shunt	resistance	is	to
infinity—the	parallel	resistance	of	an	ideal	current	source.	In	fact,
when	load	regulation	is	specified	in	Constant	Current	mode,
parallel	resistance	is	expressed	as	1/load	regulation.



Related	Topics
Constant	Current	Mode
Constant	Voltage	Mode



Local	and	Remote	Sense
A	measurement	made	with	local	sense	uses	a	single	set	of	leads	for
output	and	voltage	measurement,	as	illustrated	in	the	following	figure:

An	error	in	the	DUT	voltage	measurement	is	due	to	the	output	current
and	the	resistance	of	the	leads	used	to	connect	the	power	supply	or	SMU
to	the	load.	This	error	can	be	calculated	using	the	following	equation:
Local	Sense	Error	(Volts)	=		Iout(Rlead1	+	Rlead2)

When	the	device	is	operating	in	Constant	Voltage	mode,	local	sense
forces	the	requested	voltage	at	the	output	terminals	of	the	device.	The
actual	voltage	at	the	DUT	terminals	is	lower	than	the	requested	output
because	of	the	output	lead	resistance	error.
Measurements	made	using	remote	sense,	sometimes	referred	to	as	4-
wire	sense,	require	4-wire	connections	to	the	DUT	(and	4-wire	switches	if
a	switching	system	is	used	to	expand	the	channel	count).	Using	remote
sense	offers	the	benefit	of	more	accurate	voltage	output	and
measurements	when	the	output	lead	voltage	drop	is	significant.	In	a
remote	sense	configuration,	one	set	of	leads	carries	the	output	current,
while	another	set	of	leads	is	used	to	measure	voltage	directly	at	the	DUT
terminals,	as	illustrated	in	the	following	figure:

Although	the	current	flowing	in	the	output	leads	can	be	several	amps	or
more	depending	on	the	power	supply	or	SMU,	a	very	small	amount	of
current	flows	through	the	sense	leads	resulting	in	a	much	smaller	voltage



drop	error	for	measurements	versus	the	local	sense	error.	When	using
remote	sense	in	the	DC	Voltage	output	function,	the	output	voltage	is
forced	at	the	end	of	the	sense	leads	instead	of	the	output	terminals.
When	using	remote	sense	in	the	DC	Current	output	function,	the	voltage
limit	is	measured	at	the	end	of	the	sense	leads	instead	of	at	the	output
terminals.	Using	remote	sense	results	in	a	voltage	at	the	DUT	terminals
that	is	more	accurate	than	what	can	be	achieved	using	local	sense.
Ideally,	the	sense	leads	should	be	connected	as	close	to	the	DUT
terminals	as	possible.
When	using	remote	sense,	it	is	important	to	remember	that	the
magnitude	of	the	voltage	drop	across	the	higher	current	output	leads	is
usually	limited	to	one	or	two	volts	per	lead,	depending	on	the	power
supply	or	SMU.	When	attempting	to	force	a	voltage	using	the	DC	Voltage
output	function,	dropping	more	voltage	across	the	output	leads	than	the
specified	maximum	in	remote	sense	mode	may	result	in	a	voltage	at	the
load	that	is	less	than	the	requested	level.	When	attempting	to	force	a
current	using	the	DC	Current	output	function	while	using	either	local	or
remote	sense,	excessive	line	drop	may	force	the	power	supply	or	SMU
into	Constant	Voltage	mode	before	the	requested	current	level	can	be
reached.
Configuring	a	channel	for	remote	sense	operation	without	connecting	the
sense	leads	to	the	DUT	can	result	in	measurements	that	do	not	meet	the
published	specifications.	If	a	channel	is	configured	for	remote	sense	and
the	remote	sense	leads	are	left	open,	the	channel	may	source	a	voltage
as	large	as	20%	higher	than	the	voltage	level	or	voltage	limit.
Refer	to	your	device	specifications	document	for	more	information	about
remote	sense	support	and	the	maximum	output	lead	voltage	drop
allowed.
Remote	sense	can	be	enabled	or	disabled	using	the	niDCPower
Configure	Sense	VI,	or	the	niDCPower_ConfigureSense	function	on	a	per
output	basis	for	channels	that	support	this	feature.

Devices	with	Remote	Sense	Capabilities
Device Channel(s)

NI	PXI-4130 1
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Measuring	Resistance
Power	supplies	and	SMUs	are	capable	of	making	resistance
measurements	because	they	can	both	generate	and	measure	test
voltages	and	currents.	Because	they	can	operate	as	precision	current
sources	up	to	2	A,	these	modules	are	well	suited	to	measure	low
resistance	values.
To	measure	a	resistance	with	an	NI	power	supply	or	SMU,	select	a	test
current	that	creates	a	voltage	drop	within	module	capabilities.	After	the
channel	output	is	enabled	and	settled,	use	the	Measure	Multiple	VI	to
measure	the	actual	current	being	delivered	to	the	resistor	as	well	as	the
measured	voltage	across	the	resistor.	To	determine	the	accuracy	a
resistance	measurement,	the	accuracy	specifications	of	both	current	and
voltage	measurements	for	the	power	supply	or	SMU	should	be	taken	into
account.	For	channels	with	remote	sense	capabilities,	enabling	this
feature	results	in	a	more	accurate	voltage	measurement	at	the	resistor
terminals.
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Compensation	for	Offset	Voltages
When	measuring	low-value	resistances	thermal	voltages	may	introduce
significant	offsets	into	the	resistance	measurement	path.	If	an	offset
voltage	exists	in	series	with	the	resistance	to	be	measured	as	in	the
following	figure,	taking	a	second	measurement	at	a	different	current
output	setpoint	allows	the	offset	to	be	accounted	for	in	the	resistance
calculation.

The	two	test	currents,	I1	and	I2,	create	voltage	drops	of	V1	and	V2
respectively.	Thus,	the	following	two	equations	can	be	derived:
V1	=	I1R	+	VOS
V2	=	I2R	+	VOS
Rearranging	these	two	equations	allows	for	the	calculation	of	the
unknown	resistance	R	without	measuring	VOS.	Assuming	the	currents	I1
and	I2	are	different	the	following	equation	can	be	derived:

For	the	best	signal-to-noise	performance,	test	currents	of	opposite
polarity	should	be	used	(for	example,	+	100	mA	and		100	mA).	If	currents
of	opposite	polarity	are	not	feasible,	the	next	best	solution	is	to	use	test
currents	that	are	100x	apart	(that	is,	if	your	first	current	is	1	A,	you	should
choose	a	second	test	current	of	0.01	mA).



Resistor	Self-Heating
As	power	dissipation	in	a	resistor	increases,	the	temperature	of	the
resistor	increases	and	causes	a	change	in	the	resistance	value.	You	can
calculate	how	much	error	is	introduced	in	your	measurement	by	resistor
self-heating	from	the	derating	curve	of	Rated	Power(%)	vs.	Ambient
Temperature	commonly	given	in	resistor	specifications.
The	specifications	of	resistors	include	a	derating	curve,	similar	to	the	one
shown	in	the	following	graph.	Notice	that	this	curve	does	not	show	the
temperature	change	of	the	resistor	due	to	self-heating.	The	curve	shows
the	percentage	of	the	rated	power	that	you	can	apply	to	a	resistor	vs.	the
ambient	temperature.	So	at	70	°C	of	ambient	temperature,	you	can	apply
up	to	100%	of	the	rated	power,	but	at	100	°C	you	can	only	apply	up	to
65%	of	the	rated	power.

At	any	temperature,	the	resistor	will	have	a	temperature	change	due	to
self-heating	(ΔTSH),	so	the	actual	temperature	of	the	resistor	is	the
ambient	temperature	plus	an	unknown	ΔTSH.	Even	though	this	graph
does	not	directly	show	the	value	of	ΔTSH,	you	can	still	calculate	it.

Notice	that	at	70	°C,	applying	100%	of	the	rated	power,	the	temperature
of	the	resistor	is	equal	to	70	°C	plus	ΔTSH.	At	150	°C,	you	cannot	apply
any	power	to	the	resistor,	so	the	temperature	of	the	resistor	is	equal	to
the	ambient	temperature.	You	can	thus	infer	that	when	applying	100%	of
the	rated	power	at	70	°C	the	total	temperature	of	the	resistor	is	150	°C.
Therefore,	above	70	°C,	the	value	of	ΔTSH	increases	in	such	a	way	that
when	you	add	to	it	the	ambient	temperature	it	surpasses	150	°C.
Therefore,	you	need	to	limit	the	power	you	apply	to	the	resistor	to	keep
the	total	temperature	of	the	part	under	150	°C.	Hence,	the	value	of	ΔTSH
is	a	function	of	the	power	applied	to	the	part.



The	thermal	resistance	(θ)	is	equal	to	the	absolute	value	of	the	slope
between	the	70	°C	and	the	150	°C	points	in	the	derating	curve	shown
above.
θ	=	(150	°C—70	°C)/ΔP	=	(150	°C—70	°C/)Pmax)	°C/W

If	the	resistor	has	a	Rated	Power	at	70	°C	equal	to	0.25	W,	then	the	value
for	θ	would	be	equal	to:

θ	=	(150	°C—70	°C)/ΔP	=	(150	°C—70	°C)/250	mW	=	80	°C/(250*10–
3	W)	=	320	°C/W	=	0.32	°C/mW

To	decrease	the	thermal	resistance,	you	must	look	for	a	resistor	with
higher	rated	power,	or	find	a	way	to	"heat	sink"	the	resistor	to	the
environment.	This	can	become	complicated	and	expensive	unless	the
resistor	is	specifically	designed	for	heat	sinking.
You	can	now	calculate	the	change	in	temperature	due	to	power
dissipation	using	the	thermal	resistance	(θ)	and	the	power	being
dissipated	in	the	resistor	(product	of	voltage	and	current).	Then	you	can
use	the	temperature	coefficient	of	the	resistor	(usually	given	in	ppm/	°C)
to	calculate	the	change	in	the	resistance	value.
Resistor	self-heating	is	more	relevant	when	measuring	currents	above
400	mA.	The	self-heating	of	the	current	shunts	in	the	largest	current
ranges	for	the	NI	PXI-4110/4130	cause	an	additional	derating	on	those
modules	in	these	current	ranges.	For	more	information	about	additional
derating	in	these	ranges,	refer	to	your	device	specifications	document.	To
minimize	the	self-heating	effect	of	current	shunts	for	the	largest	current
ranges	in	these	devices,	measurements	should	be	made	as	soon	as
possible	after	enabling	the	output,	before	the	shunt	has	had	the
opportunity	to	heat	itself.



Related	Topics
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Noise
Noise—unwanted	signals	present	on	the	output	channels—can	affect
devices	connected	to	the	output	channels.
Noise	can	be	characterized	as	normal-mode	or	common-mode	noise.
Regardless	of	its	characterization,	noise	is	meaningful	only	when	it	is
specified	with	an	associated	bandwidth.



Normal-Mode	Noise
Normal-mode	noise	is	present	between	the	output	HI	terminal	and	the
output	common	LO	terminal,	appearing	either	in	series	(Constant	Voltage
mode)	or	parallel	(Constant	Current	mode)	with	the	output	of	the	device.
Normal-mode	noise	can	be	expressed	as	voltage	noise	or	current	noise,
depending	on	the	control	mode	of	the	output	channel.
AC	to	DC	rectification	causes	ripple,	a	type	of	periodic	normal-mode
noise.



Common-Mode	Noise
Common-mode	noise	is	present	between	the	output	common	LO	terminal
and	the	chassis	or	earth	ground.	In	this	sense,	the	equivalent	circuit	is	a
current	noise	source	connected	across	these	two	terminals.	When	you
connect	an	impedance	between	the	output	common/ground	and	chassis
or	earth	ground,	a	noise	current	can	flow	in	the	impedance,	resulting	in
an	unexpected	offset	or	other	undesirable	error.



Output	Capacitance	Considerations
To	help	reduce	noise	and	ripple	when	the	device	is	operating	in	a	high-
current	range,	NI	recommends	setting	the	niDCPower	Output
Capacitance	property	or	the
NIDCPOWER_ATTR_OUTPUT_CAPACITANCE	attribute	to	HIGH	for
devices	that	support	this	feature.	Remember	that	a	larger	capacitance
results	in	a	slower	output	response.	Refer	to	Load	Considerations	for
more	information	about	capacitive	loads.

Note		The	only	valid	output	capacitance	setting	on	all	channels	for
the	NI	PXI-4110	is	HIGH.	For	more	information	about	reducing
noise	in	high-current	ranges	with	the	NI	PXI-4130,	refer	to	Output
Capacitance	Selection.
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Measurement	Noise	Rejection
In	many	environments,	line	noise	(for	example,	50	Hz	or	60	Hz)	or	other
unwanted	periodic	signals	may	be	present	in	a	system	and	can	degrade
measurement	quality.	You	can	program	your	device	to	reject	periodic
signals	and	their	harmonics	by	configuring	the	niDCPower	Samples	to
Average	property	or	the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE
attribute	according	to	the	following	table.

Number	of	Samples	to
Average

Frequencies	Rejected	for	3	kHz	Sample
Rate

1 3	kHz
50 60	Hz
60 50	Hz
300 50	Hz	and	60	Hz

For	frequencies	not	listed	in	this	table,	use	the	following	formula:
N	=	3000/Fr
where	N	is	the	number	of	samples	to	average	and	Fr	is	the	frequency
rejected.

Note			To	improve	noise	reduction	while	keeping	frequency
rejection,	set	the	number	of	samples	to	average	to	N,	2N,	3N,	and
so	on.	The	maximum	allowed	samples	to	average	is	511.
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Considerations	When	Measuring	Noise
Exercise	care	when	measuring	noise	on	an	output	device,	such	as	a
power	supply	or	SMU.	When	verifying	the	specified	wideband	noise	of	a
device,	the	effects	of	ground	loops,	unnecessarily	long	probe	ground
leads,	and	electrically	noisy	environments	can	combine	and	skew	your
measurements.
Observe	the	following	recommendations	when	measuring	the	noise	of	a
power	supply	or	SMU:

Connect	the	probe	directly	to	the	terminals	of	the	power	supply	or
SMU.	Do	not	use	long	leads,	loose	wires,	or	unshielded	cables.
Limit	the	probe	ground	lead	to	a	few	inches	at	most.	Connect	this
lead	directly	to	the	output	common/ground	terminal	of	the
appropriate	channel.
Limit	the	bandwidth	of	the	measurement	device	to	the	bandwidth	of
interest.	For	example,	making	a	20	MHz	noise	measurement	with	a
200	MHz	bandwidth	instrument,	may	not	yield	the	specified	values.
To	avoid	measuring	the	environment	noise	instead	of	the	device
noise,	exercise	caution	when	making	measurements	in	a	modern
laboratory	environment	with	computers,	electronic	ballasts,
switching	power	supplies,	and	so	on.



Related	Topic
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Ranges
NI	power	supplies	and	SMUs	use	one	or	more	ranges	for	voltage	and
current	output,	as	well	as	one	or	more	ranges	for	voltage	and	current
measurement.	Use	the	highest	resolution	(smallest)	range	possible	for	a
particular	application	to	get	maximum	output	and	measurement	accuracy.
Refer	to	the	specifications	document	for	your	device	or	NI	PXI-4110	or	NI
PXI-4130	for	more	information	about	what	ranges	are	available	for	a
particular	channel	on	your	device.
Ranges	are	typically	described	as	the	maximum	possible	value	from	zero
that	the	range	can	output	or	measure	(not	including	the	overrange).	For
example,	in	the	20	mA	current	level	range,	the	current	level	can	be
configured	up	to	20	mA.
When	configuring	an	output	range,	if	you	request	a	range	that	differs	from
the	ranges	described	in	your	device	specifications,	NI-DCPower	selects
the	highest	resolution	(smallest)	range	available	that	accommodates	the
requested	range.	For	example,	on	a	device	with	only	20	mA	and	200	mA
current	limit	ranges,	if	you	request	100	mA	for	the	current	range,	NI-
DCPower	selects	the	200	mA	range.
There	are	four	configurable	output	ranges	for	each	device	channel	:
voltage	level	range,	current	limit	range,	current	level	range,	voltage	limit
range.	When	the	output	function	is	set	to
NIDCPOWER_VAL_DC_VOLTAGE	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Voltage	using	the
niDCPower	Configure	Output	Function	VI,	the	voltage	level	range	and
current	limit	range	are	in	use.	When	the	output	function	is	set	to
NIDCPOWER_VAL_DC_CURRENT	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Current	using	the
niDCPower	Configure	Output	Function	VI,	the	current	level	range	and
voltage	limit	range	are	in	use.
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Changing	Ranges
You	can	use	the	following	four	VIs	and	functions	to	configure	output
ranges	for	your	device.

VI	Name Function	Name
niDCPower	Configure	Voltage
Level	Range

niDCPower_ConfigureVoltageLevelRange

niDCPower	Configure	Current
Limit	Range

niDCPower_ConfigureCurrentLimitRange

niDCPower	Configure	Voltage
Limit	Range

niDCPower_ConfigureVoltageLimitRange

niDCPower	Configure	Current
Level	Range

niDCPower_ConfigureCurrentLevelRange

The	configured	range	must	be	able	to	accommodate	the	configured
output	value.	For	example,	if	the	current	limit	range	is	1	A	and	the	current
limit	is	50	mA,	changing	the	current	limit	range	to	20	mA	is	not	allowed
because	50	mA	is	not	possible	in	the	new	range.	When	changing	ranges
in	immediate	configuration	mode	be	aware	of	the	order	of	the	output
range	and	output	value	changes	because	the	configuration	change	takes
effect	immediately	in	this	mode.	To	avoid	ordering	issues,	NI
recommends	that	you	configure	the	output	range	and	output	value	in
delayed	configuration	mode.	In	this	mode	you	can	configure	the	output
range	and	the	output	value	in	any	order.	Alternatively,	you	can	enable
autoranging	for	the	range	you	want	to	change.

NIDCPowerVIRef.chm::/niDCPower_Configure_Voltage_Level_Range.html
NIDCPowerCRef.chm::/cviniDCPower_ConfigureVoltageLevelRange.html
NIDCPowerVIRef.chm::/niDCPower_Configure_Current_Limit_Range.html
NIDCPowerCRef.chm::/cviniDCPower_ConfigureCurrentLimitRange.html
NIDCPowerVIRef.chm::/niDCPower_Configure_Voltage_Limit_Range.html
NIDCPowerCRef.chm::/cviniDCPower_ConfigureVoltageLimitRange.html
NIDCPowerVIRef.chm::/niDCPower_Configure_Current_Level_Range.html
NIDCPowerCRef.chm::/cviniDCPower_ConfigureCurrentLevelRange.html


Overranging
If	the	niDCPower	Overranging	Enabled	property	or	the
NIDCPOWER_ATTR_OVERRANGING_ENABLED	attribute	is	set	to
TRUE,	the	valid	values	for	the	programmed	output	(voltage	level,	current
limit,	current	level,	and	voltage	limit)	may	be	extended	beyond	their
normal	operating	range	on	channels	that	support	this	feature.	Enabling
overranging	for	a	particular	device	enables	this	feature	for	both	output
current	and	voltage	on	all	channels.	Refer	to	NI	PXI-4110	or	NI	PXI-4130
to	determine	if	your	device	supports	overranging.

NIDCPowerProperties.chm::/pnidcpower_overranging_enabled.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_OVERRANGING_ENABLED.html


Output	Autoranging
When	autoranging	is	enabled	for	an	output	range,	NI-DCPower
automatically	changes	the	output	range	based	on	the	configuration
output	value.	NI-DCPower	automatically	changes	to	the	highest
resolution	(smallest)	range	that	can	accommodate	the	configured	output
value.	You	can	selectively	enable	autoranging	for	any	output	range	on	a
channel.
Use	the	following	properties	and	attributes	to	configure	your	device	for
autoranging.

Attributes Properties
NIDCPOWER_ATTR_VOLTAGE_LEVEL_AUTORANGE niDCPower

Voltage	Level
Autorange

NIDCPOWER_ATTR_CURRENT_LIMIT_AUTORANGE niDCPower
Current	Limit
Autorange

NIDCPOWER_ATTR_CURRENT_LEVEL_AUTORANGE niDCPower
Current	Level
Autorange

NIDCPOWER_ATTR_VOLTAGE_LIMIT_AUTORANGE niDCPower
Voltage	Limit
Autorange

NIDCPowerCref.chm::/NIDCPOWER_ATTR_VOLTAGE_LEVEL_AUTORANGE.html
NIDCPowerProperties.chm::/pnidcpower_Voltage_Level_Autorange.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_CURRENT_LIMIT_AUTORANGE.html
NIDCPowerProperties.chm::/pnidcpower_Current_Limit_Autorange.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_CURRENT_LEVEL_AUTORANGE.html
NIDCPowerProperties.chm::/pnidcpower_Current_Level_Autorange.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_VOLTAGE_LIMIT_AUTORANGE.html
NIDCPowerProperties.chm::/pnidcpower_Voltage_Limit_Autorange.html


Related	Topics
NI	PXI-4130	Range	Considerations



Resolution
Resolution	is	applicable	to	both	output	and	measurement	circuits	of
power	supplies	and	SMUs.
For	power	supplies	and	SMUs,	output	and	measurement	resolution	are
usually	specified	in	absolute	units,	like	μV	or	nA.



Output	Resolution
Resolution	of	a	power	supply	or	SMU	output	channel	is	the	smallest
possible	change	that	can	be	made	to	the	output	voltage	or	current	level.
This	limitation	is	imposed	because	of	the	finite	number	of	steps	that	are
available	in	the	device	DAC	circuit.
Output	resolution	can	be	calculated	by	dividing	the	total	span	of	the
output	range	by	the	number	of	possible	quantized	values	the	DAC	allows.
For	example,	consider	a	±6	V	output	range	when	using	a	16-bit	DAC:

Resolution	=	(+6	V		(6	V))	/	(2161)	=	12	V	/	65535	=	183	μV



Measurement	Resolution
Measurement	resolution	of	a	power	supply	or	SMU	is	the	smallest
change	in	the	voltage	or	current	measurement	that	can	be	detected	by
hardware.	The	resolution	for	a	particular	channel	is	based	on	the
resolution	of	the	ADC	used	to	digitize	the	measured	signal.	When	taking
a	measurement	of	the	output,	the	ideal	ADC	coerces	the	actual	value	to
the	nearest	ADC	code.	The	codes	are	equally	spaced	across	the
measurement	range	of	the	ADC,	each	separated	from	the	previous	and
next	code	by	the	magnitude	of	the	power	supply	or	SMU	resolution.
For	example,	consider	a	±	200	μA	measurement	range	when	using	an
18-bit	ADC:

Resolution	=	(+200	μA	-	(-200	μA))	/	(218-1)	=	400	μA	/	262143	=	1.5	nA



Sensitivity
Sensitivity	is	the	smallest	unit	of	a	given	parameter	that	can	be
meaningfully	detected	with	an	instrument	under	specified	conditions.	This
unit	is	generally	equal	to	the	resolution	in	the	smallest	range	of	a	power
supply	or	SMU.



Rise	Time
Rise	time	specifies	the	time	duration	for	the	output	to	transition	from	10%
to	90%	of	the	programmed	voltage	at	the	maximum	current.	Use	the
following	equation	to	calculate	the	rise	time	for	a	single-pole	system.
Rise	Time	=	2.2	×	time	constant



Bandwidth
Using	the	rise	time,	you	can	calculate	the	bandwidth	using	the	following
equation.
Bandwidth	=	0.35	/	Rise	Time



Settling	Time
Settling	time	specifies	the	time	required	for	an	output	channel	to	reach	a
stable	mode	of	operation.	You	can	calculate	the	settling	time	to	any
maximum	level	of	error	desired	for	a	single-pole	system	using	the	time
constant	and	the	following	rule:
Settling	Time	=	(decades	×	2.3	×	time	constant)
where	decades	is	decades	of	settling	as	determined	by	the	desired
maximum	error	(settling	to	1%	error	=	2	decades,	0.1%	=	3	decades,	and
so	on).	For	example,	calculating	the	settling	to	1%	error,	settling	time	is	(2
×	2.3	×	time	constant);	calculating	the	settling	time	to	0.1%	error,	settling
time	is	(3	×	2.3	×	time	constant).
If	the	maximum	error	desired	falls	on	an	uneven	number	of	decades,	use
the	following	equation	to	calculate	settling	time:
Settling	Time	=	-Ln(maximum	error	desired)	×	time	constant
where	Ln	is	the	natural	logarithm.
For	example,	calculating	the	settling	to	0.05%	error,	settling	time	is	(-
Ln(0.0005)	×	time	constant),	or	(7.6	×	time	constant).
Settling	time	can	be	added	by	placing	a	delay	between	the	function	used
to	set	an	output	and	the	function	used	to	measure	the	output.	In
LabVIEW,	the	Wait(ms),	Wait	Until	Next	ms	Multiple,	or	Time	Delay
functions	can	be	used	to	add	additional	delay	time.	Refer	to	the	LabVIEW
Help	for	more	information	about	these	VIs.



Sourcing	and	Sinking
The	terms	sourcing	and	sinking	describe	power	flow	into	and	out	of	a
device.	Devices	that	are	sourcing	power	are	delivering	power	into	a	load,
while	devices	that	are	sinking	power	behave	like	a	load,	absorbing	power
that	is	being	driven	into	them	and	providing	a	return	path	for	current.
A	battery	is	one	example	of	a	device	that	is	capable	of	both	sourcing	and
sinking	power.	During	the	charging	process	the	battery	acts	as	a	power
sink	by	drawing	current	from	the	charging	circuit.	After	it	has	been
removed	from	the	charger	and	installed	into	an	electronic	device,	the
battery	begins	to	act	as	a	source	that	delivers	power	to	a	load.
The	following	quadrant	diagram	graphically	represents	whether	a
particular	channel	is	sourcing	or	sinking	power.	Quadrants	consist	of	the
various	combinations	of	positive	and	negative	currents	and	voltages.
Quadrants	I	and	III	represent	sourcing	power,	while	quadrants	II	and	IV
represent	sinking	power.

For	example,	when	you	have	a	positive	voltage	and	current	flowing	out	of
the	positive	terminal	(that	is,	a	positive	current),	the	output	operation	falls
within	Quadrant	I	and	is	sourcing	power.	When	you	have	a	positive
voltage	and	a	current	flowing	into	the	positive	terminal	(that	is,	a	negative
current),	the	output	operation	falls	within	Quadrant	II,	and	is	sinking
power.
A	single-quadrant	channel	on	a	power	supply	can	operate	only	in	one
quadrant.	For	example,	while	the	NI	PXI-4110	has	multiple	channels
capable	of	sourcing	power	in	either	Quadrant	I	or	Quadrant	III,
individually,	each	channel	on	the	NI	PXI-4110	can	operate	only	within	one
quadrant	(channels	0	and	1	operate	only	within	Quadrant	I,	and	channel



2	operates	only	within	Quadrant	III).	Thus,	all	channels	on	the	NI	PXI-
4110	are	single-quadrant	supplies.
Devices	that	are	capable	of	sourcing	power	in	both	Quadrant	I	and	III	are
sometimes	referred	to	as	bipolar	because	they	can	generate	both
positive	and	negative	voltages	and	currents.	Bipolar	output	channels	may
or	may	not	have	current	sinking	capabilities	(Quadrants	II	and	IV).
An	output	channel	on	a	four-quadrant	power	supply	or	SMU	can	both
source	and	sink	power	with	a	positive	or	negative	voltage	and	current.
For	example,	the	NI	PXI-4130	SMU	channel	(channel	1)	is	capable	of
both	sourcing	power	in	Quadrant	I	or	Quadrant	III	and	sinking	power	in
Quadrant	II	or	Quadrant	IV.	Thus,	the	NI	PXI-4130	SMU	channel	is	a
bipolar,	four-quadrant	device.	For	NI	four-quadrant	devices,	it	is	important
to	remember	that	an	auxiliary	power	supply	is	required	for	both	sourcing
and	sinking	power	to	reach	the	full	current	capability	of	the	device.	For
more	information	about	auxiliary	power,	refer	to	the	Internal	and	Auxiliary
Power	topic	for	your	device.
Because	of	the	required	power	dissipation,	sourcing	and	sinking
capabilities	for	a	channel	are	not	always	identical.	Refer	to	NI	PXI-4110
or	NI	PXI-4130	for	more	information	about	the	sourcing	and	sinking
capabilities	of	your	device.
The	following	table	summarizes	the	power	capabilities	per	channel	for
each	NI	power	supply	and	SMU	device.

Device	Name Channel
Quadrant

I II III IV
NI	PXI-4110 0 6	W

1 20	W
2 20	W

NI	PXI-4130 0 6	W
1 40	W 10	W* 40	W 10	W*

*These	values	are	valid	only	up	to	an	ambient	temperature	of	30°C.



Devices
Expand	this	book	for	NI	power	supply	and	SMU	device-specific
information.



NI	PXI-4110
The	NI	PXI-4110	has	three	single-quadrant	DC	power	supply	channels.
The	following	table	lists	the	DC	voltage	ranges	supported	by	each
channel.

Channel
Range

Output Measurement
0 +6	V +6	V
1 +20	V +20	V
2 -20	V -20	V
These	channels	support	5%	overranging	when	overranging	is	enabled.

The	following	table	lists	DC	current	ranges	supported	by	the	NI	PXI-4110.

Channel
Range

Output Measurement
0 1	A 1	A
1	and	2 20	mA 20	mA

1	A* 1	A*

*Without	auxiliary	power,	the	maximum	current	in	the	1A	range	is	100
mA.
These	channels	support	5%	overranging	when	this	overranging	is
enabled.

The	following	diagrams	illustrate	the	output	voltage	and	current
capabilities	of	each	channel	on	the	NI	PXI-4110:



				 				

Note		Channel	2	on	the	NI	PXI-4110	is	a	single-quadrant	power
supply	and	always	operates	within	Quadrant	III.	However,	the
polarity	of	the	measured	voltage	is	negative	(measured	using	the
niDCPower	Measure	VI	or	the	niDCPower	Measure	Multiple	VI)
and	the	polarity	of	the	measured	current	is	positive.	The	difference
in	polarities	is	due	to	the	positive	current	direction	on	channel	2
being	defined	as	current	flowing	into	the	common	floating	GND.

For	more	information	about	the	NI	PXI-4110	specifications,	refer	to
Related	Documentation.

NIDCPowerVIRef.chm::/niDCPower_Measure.html
NIDCPowerVIRef.chm::/niDCPower_Measure_Multiple.html


NI	PXI-4110	Front	Panel
The	following	figure	illustrates	the	NI	PXI-4110	front	panel.

Item Description
A Output	Connector,	Terminal	0 Channel	0	(0	to	+6	V)
B Output	Connector,	Terminal	1 GND
C Output	Connector,	Terminal	2 Channel	1	(0	to	+20	V)
D Output	Connector,	Terminal	3 Common	Floating	GND



E Output	Connector,	Terminal	4 Common	Floating	GND
F Output	Connector,	Terminal	5 Channel	2	(0	to	-20	V)
G Auxiliary	Power	Input	Connector,

Terminal	0
Auxiliary	Power	Input	(+11	V	to
+15.5	V)

H Auxiliary	Power	Input	Connector,
Terminal	1

GND

I Auxiliary	Power	Input	Fuse	Holder —
J Auxiliary	Power	Input	Status

Indicator
LED

K Channel	2	Output	Status	Indicator LED
L Channel	1	Output	Status	Indicator LED
M Channel	0	Output	Status	Indicator LED



Status	Indicators
Status	indicators	on	the	front	panel	of	the	NI	PXI-4110	provide	feedback
about	device	operation.
Use	the	following	table	to	determine	the	state	of	an	output	channel	using
a	status	indicator.

Status
Indicator Channel	Output	State

(Off) Disabled
Green Enabled	(Constant	Voltage	mode)
Amber Enabled	(Constant	Current	mode)
Red Disabled	because	of	error,	such	as	an	overtemperature

condition

Use	the	following	table	to	determine	the	state	of	the	auxiliary	power	input
using	the	status	indicator.

Status	Indicator Auxiliary	Power	Input	State
(Off) Auxiliary	power	input	disconnected	or	out	of	range
Green* Auxiliary	power	input	connected	and	within	range
*Does	not	indicate	that	the	auxiliary	power	is	in	use.	To	determine	if	the
NI	PXI-4110	is	using	auxiliary	power,	use	the	niDCPower	Power	Source
In	Use	property	or	the	NIDCPOWER_ATTR_POWER_SOURCE_IN_USE
attribute.

NIDCPowerProperties.chm::/pnidcpower_Power_Source_In_Use.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_POWER_SOURCE_IN_USE.html


Operating	the	Device
Expand	this	book	for	information	about	using	the	NI	PXI-4110.



Internal	and	Auxiliary	Power
When	drawing	internal	power	from	the	PXI	backplane,	channels	1	and	2
of	the	NI	PXI-4110	are	fully	operational	at	a	lower	output	current(≤100
mA)	and	do	not	require	an	auxiliary	power	source.
If	your	application	requires	additional	current,	you	can	connect	an
auxiliary	DC	power	supply	capable	of	providing	11	V	to	15.5	V	and	≥60	W
to	increase	the	output	current	capability	of	these	channels	to	1	A.	NI
offers	the	APS-4100,	an	auxiliary	power	source	for	NI	DC	power
supplies.	Visit	ni.com	for	more	information.

Note		Channel	0	has	the	same	output	capabilities	under	internal
power	as	auxiliary	power.



Using	Auxiliary	Power
Complete	the	following	steps	to	connect	and	use	auxiliary	power:

1.	 Connect	a	11	V	to	15.5	V,	≥60	W	power	source	to	the	auxiliary
power	input	connector	on	the	NI	PXI-4110	front	panel.

2.	 Open	a	new	session	to	the	device.	NI-DCPower	automatically
uses	the	auxiliary	power	source	when	available.	To	override	this
feature,	use	the	niDCPower	Power	Source	property	or	the
NIDCPOWER_ATTR_POWER_SOURCE	attribute.

Tip		Use	the	niDCPower	Power	Source	In	Use	property	or
the	NIDCPOWER_ATTR_POWER_SOURCE_IN_USE
attribute	to	programmatically	determine	which	power
source	is	in	use.

NIDCPowerProperties.chm::/pnidcpower_Power_Source.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_POWER_SOURCE.html
NIDCPowerProperties.chm::/pnidcpower_Power_Source_In_Use.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_POWER_SOURCE_IN_USE.html


Resuming	Operation	After	a	Shutdown
In	case	of	auxiliary	power	loss	during	operation,	the	isolated	outputs
(channels	1	and	2)	are	disabled,	and	the	power	supply	is	shut	down	to
prevent	damage	to	the	NI	PXI-4110	and	the	load.	If	a	shutdown	occurs,
complete	the	following	steps	to	resume	operation:

1.	 Troubleshoot	the	failure.
2.	 Restore	auxiliary	power.
3.	 Reset	the	power	supply	using	the	niDCPower	Reset	VI	or	the

niDCPower_reset	function.
4.	 Reconfigure	the	power	supply.

NIDCPowerVIRef.chm::/niDCPower_Reset.html
NIDCPowerCRef.chm::/cviniDCPower_Reset.html


Changing/Removing	Auxiliary	Power
Complete	the	following	steps	to	change	or	remove	auxiliary	power	from
the	NI	PXI-4110:

Tip		It	is	often	more	convenient	to	close	the	existing	session	and
open	a	new	session	to	the	device	when	managing	auxiliary	power
state	changes.

1.	 Disable	the	output	channels.
2.	 Disconnect/connect	the	auxiliary	power	source.
3.	 Reset	the	power	supply	using	the	niDCPower	Reset	VI	or	the

niDCPower_reset	function.
4.	 Reconfigure	the	power	supply.

NIDCPowerVIRef.chm::/niDCPower_Reset.html
NIDCPowerCRef.chm::/cviniDCPower_Reset.html


Cascading	Outputs
Caution		Do	not	exceed	60	VDC	from	any	terminal	to	ground
when	cascading	power	supplies.

Because	channels	1	and	2	on	the	NI	PXI-4110	are	isolated	outputs,	you
can	cascade	multiple	channels	in	series	to	generate	greater	output
voltage.	For	safety	reasons,	all	the	terminals	must	be	<60	VDC	from
ground.	Any	terminal	on	the	isolated	channels	can	be	connected	to
ground.	When	you	cascade	channels	in	series,	the	NI	PXI-4110	can
generate	up	to	46	V	at	1	A,	as	illustrated	in	the	following	figures:

Note		The	NI	APS-4100	is	required	for	current	above	100	mA.

Caution		The	NI	PXI-4110	does	not	provide	isolation	when	using
CH	0.

Similarly,	you	can	use	the	NI	PXI-4110	to	cascade	multiple	channels	in
parallel	to	generate	greater	output	current.	NI	recommends	cascading	no
more	than	two	output	channels	in	parallel.	Cascade	channels	0	and	1	in
parallel	to	generate	up	to	2	A	at	6	V,	as	shown	in	the	following	figure:

Note		The	NI	APS-4100	is	required	for	current	above	1.1	A	in	this
cascaded	configuration.



Note		When	cascading	multiple	channels	in	parallel,	verify	that	all
the	channels	you	are	cascading	are	set	to	output	the	same	voltage
level	or	voltage	limit.

For	more	information	about	cascading	the	outputs	of	the	NI	PXI-4110,
refer	to	the	NI	Developer	Zone	document,	Cascading	the	Outputs	of	a
DC	Power	Supply	to	Extend	Voltage	and	Current	Ranges	at	ni.com/zone.

javascript:WWW(WWW_Zone)


Measurement	Averaging
The	NI	PXI-4110	averages	measurement	samples	to	reduce	noise	and
improve	sensitivity.	You	can	set	the	number	of	samples	to	average
programmatically	using	the	niDCPower	Samples	To	Average	property	or
the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute.

Note		When	you	set	the	niDCPower	Samples	To	Average	property
or	the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute,	the
output	channel	measurements	may	move	out	of	synchronization.
Refer	to	the	niDCPower	Reset	Average	Before	Measurement
property	or	the
NIDCPOWER_ATTR_RESET_AVERAGE_BEFORE_MEASUREMENT
attribute	for	more	information	about	measurement	averaging	and
synchronization.

NIDCPowerProperties.chm::/pnidcpower_Samples_To_Average.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE.html
NIDCPowerProperties.chm::/pnidcpower_Reset_Average_Before_Measurement.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_RESET_AVERAGE_BEFORE_MEASUREMENT.html


Determining	Measurement	Rate
Although	the	measurement	speed	of	the	NI	PXI-4110	is	3	kS/s	for	all
voltage	and	current	measurements,	the	measurement	rate	of	the	NI	PXI-
4110	can	vary	depending	on	the	setting	of	the	niDCPower	Samples	To
Average	property	or	the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE
attribute.
The	default	value	of	the	niDCPower	Samples	To	Average	property	and
the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	is	10.	As
expressed	in	the	following	equation,	the	NI	PXI-4110	returns	300
measurements	per	second	using	the	default	value.

	
If	no	measurement	averaging	is	used(Samples	To	Average	=	1),	the
NI	PXI-4110	returns	3,000	measurements	per	second.
While	measuring	without	averaging	yields	the	fastest	measurement	rate,
noise	from	the	environment	(for	example,	the	50	Hz	or	60	Hz	noise
introduced	by	cabling)	increases	measurement	uncertainty.
Adjust	the	niDCPower	Samples	To	Average	property	or	the
NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	as	necessary	to
optimize	the	noise	performance	and	measurement	rate	for	your
application.

Note		Measurement	rate	refers	only	to	the	hardware	measurement
rate	and	does	not	include	software	latency.



Rejecting	Noise
If	you	know	the	noise	frequency,	you	can	reject	it	from	the	signal.	To
determine	the	number	of	measurements	necessary	to	reject	noise	from	a
signal,	divide	the	measurement	speed	of	the	NI	PXI-4110	by	a	full
wavelength	cycle	of	noise.
Example	1
To	reject	60	Hz	noise	frequency	from	a	signal,	average	50	measurements
(3	kHz/60	Hz	=	50).
Example	2
To	reject	50	Hz	noise	frequency	from	a	signal,	average	60	measurements
(3	kHz/50	Hz	=	60).

Tip		Set	the	niDCPower	Samples	To	Average	property	or	the
NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	to	300,	an
even	multiple	of	both	60	kHz	and	50	kHz,	to	actively	reject	both
noise	frequencies.



Protection
The	output	channels	and	the	auxiliary	power	input	of	the	NI	PXI-4110	are
protected	against	overcurrent,	overvoltage,	inverse	voltage,	and
overtemperature	conditions.



Output	Channel	Protection
All	output	channels	on	the	NI	PXI-4110	are	current-limited	and	fused.	In
the	event	of	an	overcurrent,	overvoltage,	or	inverse	voltage	condition,	an
output	channel	fuse	may	blow	to	protect	the	NI	PXI-4110	and	the	load.
When	its	fuse	is	blown,	an	output	channel	can	source	only	a	few
milliamperes	of	current	regardless	of	the	programmed	current	limit.

Caution		Each	output	channel	of	the	NI	PXI-4110	can	withstand
the	application	of	an	external	voltage	up	to	10	V	beyond	the	rated
output	level.	Applying	an	external	voltage	greater	than	10	V
beyond	the	rated	output	level	can	damage	the	output	channel.

In	the	event	of	an	overtemperature	condition	(that	is,	the	enclosure	or
component	temperatures	exceed	safe	operating	limits),	the	thermal
shutdown	circuits	on	the	NI	PXI-4110	disable	the	output	channel	that
indicated	the	failure	condition.	When	disabled,	an	output	channel	can
only	be	reset	programmatically	after	the	failure	condition	is	cleared.



Auxiliary	Input	Protection
The	auxiliary	power	input	of	the	NI	PXI-4110	can	accept	voltages	from
11	V	to	15.5	V.	Applying	a	voltage	below	11	V	or	above	15.5	V	disables
the	auxiliary	power	input.
In	the	event	of	an	overvoltage	condition	(that	is,	applying	voltages	>20	V
to	the	auxiliary	power	input),	crowbar	protection	is	enabled.	Crowbar
protection	shunts	the	auxiliary	power	input	to	ground.
In	the	event	of	an	overcurrent	(>6.3	A)	or	an	inverse	voltage	condition,
the	auxiliary	power	input	fuse	may	blow	to	protect	the	NI	PXI-4110	and
the	load.	You	can	use	the	niDCPower	Auxiliary	Power	Source	Available
property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	to	troubleshoot	the	auxiliary	power	input	fuse.

NIDCPowerProperties.chm::/pnidcpower_auxiliary_power_source_available.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE.html


Related	Topics
Replacing	a	Fuse
Troubleshooting



Range	Considerations
It	is	not	possible	to	change	the	measurement	range	of	the	NI	PXI-4110
independently	of	the	output	range.	The	measurement	range	is	implicitly
selected	based	on	the	configured	output	range.	The	selected
measurement	range	is	large	enough	to	measure	any	voltage	or	current
possible	in	the	configured	output	range.
The	voltage	output	can	be	set	to	any	value	between	0%	and	100%	of	the
active	range	using	the	niDCPower	Configure	Voltage	Level	VI	or	the
niDCPower_ConfigureVoltageLevel	function,	or	the	niDCPower	Configure
Voltage	Limit	VI	or	the	niDCPower_ConfigureVoltageLimit	function.	Current
output	can	be	set	to	any	value	between	1%	and	100%	of	the	active	range
using	the	niDCPower	Configure	Current	Level	VI	or	the
niDCPower_ConfigureCurrentLevel	function,	or	the	niDCPower	Configure
Current	Limit	VI	or	the	niDCPower_ConfigureCurrentLimit	function.
Measurements	for	both	voltage	and	current	can	be	made	from	0%	to
105%	of	the	active	range	using	the	niDCPower	Measure	Multiple	VI	or
the	niDCPower_MeasureMultiple	function.	Refer	to	Overranging	for	general
information	about	enabling	overranging	in	software.

niDCPowerVIRef.chm::/niDCPower_Configure_Voltage_Level.html
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niDCPowerCRef.chm::/cviniDCPower_MeasureMultiple.html


Overranging
Enabling	overranging	for	a	particular	channel	of	the	NI	PXI-4110	extends
current	and	voltage	output	setpoint	capabilities	up	to	105%	of	the	output
range.	Overranging	is	applicable	to	output	ranges	only	and	does	not
apply	to	measurement	ranges	(the	NI	PXI-4110	is	capable	of	making
measurements	up	to	105%	of	the	output	range	by	default).
An	auxiliary	power	supply	providing	at	least	12	V	at	the	input	terminals
should	be	used	when	enabling	overranging	for	channel	1.	Refer	to
Ranges	for	more	information	about	enabling	or	disabling	overranging	for
a	particular	channel.



Related	Topics
Ranges



Replacing	a	Fuse
All	of	the	input	and	output	connections	on	the	NI	PXI-4110	front	panel
have	user-replaceable	fuses.	Refer	to	the	table	below	for	fuse	ratings	and
manufacturer	information.

Input/Output Fuse	Rating Description
Recommended

Manufacturer	Part
Number

Channels	0,
1,	and	2

F	1.5	A	125	V User-replaceable
chip	fuse

Littelfuse	045301.5

Auxiliary
power	input

T	6.3	A	L	250	V User-replaceable
5	x	20	mm	glass
fuse

Littelfuse	21806.3

To	replace	a	fuse	on	the	NI	PXI-4110,	complete	the	following	steps:
1.	 Shut	down	the	chassis.
2.	 Disconnect	all	output	and	auxiliary	power	connections.
3.	 Remove	the	NI	PXI-4110	from	the	chassis.
4.	 Identify	the	fuse	you	want	to	replace	using	the	following	figure:

1 Output	Channel	Fuse
(Channel	0)

4 Auxiliary	Input	Fuse
5 Spare	Output	Channel



2 Output	Channel	Fuse
(Channel	2)

3 Output	Channel	Fuse
(Channel	1)

Fuse

5.	 Remove	the	fuse.
(Output	channel	fuse)	Using	small	pliers,	gently	pull	the
fuse	to	release	it	from	the	fuse	holder.
(Auxiliary	input	fuse)

a.	 Using	a	flathead	screwdriver,	turn	the	fuse	holder
cap	counter-clockwise	to	release	it	from	the	NI	PXI-
4110	front	panel.

b.	 Gently	pull	the	auxiliary	power	input	fuse	to	release
it	from	the	fuse	holder	cap.

6.	 Install	the	replacement	fuse.
(Output	channel	fuse)	Using	small	pliers,	gently	place	the
replacement	fuse	into	the	fuse	holder.

Note		You	can	use	the	spare	fuse	included	on	the
NI	PXI-4110	to	replace	an	output	channel	fuse.

(Auxiliary	input	fuse)	Slide	the	replacement	fuse	into	the
fuse	holder	cap,	and	screw	the	cap	clockwise	to	replace	it
on	the	NI	PXI-4110	front	panel.



Troubleshooting
If	the	NI	PXI-4110	is	operating	incorrectly,	perform	the	following	actions:

Verify	that	the	hardware	and	software	are	properly	installed.
Verify	that	all	connections,	including	the	front	panel	connections	to
the	output	channels	and	auxiliary	power	supply	(if	applicable),	are
secure.
Verify	that	the	output	channels	are	enabled.	If	necessary,	use	the
niDCPower	Configure	Output	Enabled	VI	or	the
niDCPower_ConfigureOutputEnabled	function	to	enable	the	output
channels.
Inspect	all	fuses,	and	verify	that	each	is	in	working	condition.	If
necessary,	replace	any	blown	fuses.

Tips		Although	blown	output	channel	and	auxiliary	power	input
fuses	are	not	software	detectable,	you	can	use	the
niDCPower	Auxiliary	Power	Source	Available	property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	to	troubleshoot	the	auxiliary	power	input	fuse.	

If	you	suspect	a	blown	output	channel	fuse,	keep	in	mind	that	an
output	channel	with	a	blown	fuse	can	source	only	a	few
milliamperes	of	current	regardless	of	the	programmed	current
limit.

Run	a	self-test	on	the	NI	PXI-4110	using	the	niDCPower	Self	Test
VI	or	the	niDCPower_self_test	function.	If	the	NI	PXI-4110	is
damaged,	contact	NI	for	information	about	repair.

NIDCPowerVIRef.chm::/niDCPower_Configure_Output_Enabled.html
NIDCPowerCRef.chm::/cviniDCPower_ConfigureOutputEnabled.html
NIDCPowerProperties.chm::/pnidcpower_auxiliary_power_source_available.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE.html
NIDCPowerVIRef.chm::/niDCPower_Self_Test.html
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NI	PXI-4130
The	NI	PXI-4130	consists	of	two	output	channels.	Channel	0,	also
referred	to	as	the	utility	channel,	is	a	single-quadrant	power	supply.
Channel	1,	the	SMU	channel,	is	a	four-quadrant,	bipolar	power	source-
measure	unit.	The	following	table	lists	the	DC	voltage	ranges	supported
by	each	channel.

Channel
Range

Output Measurement
0 +6	V +6	V
1 ±20	V ±20	V

±6	V
These	channels	support	5%	overranging	when	overranging	is	enabled.

The	following	table	lists	DC	current	ranges	supported	by	the	NI	PXI-4130.

Channel
Range

Output Measurement
0 1	A 1	A
1 200	μA 200	μA

2	mA 2	mA
20	mA 20	mA
200	mA* 200	mA*

2	A* 2	A*

*See	Internal	and	Auxiliary	Power	for	limitations	when	this	device	is
under	internal	power.
These	channels	support	5%	overranging	when	overranging	is	enabled.

The	following	diagrams	illustrate	the	output	voltage	and	current
capabilities	of	each	channel	on	the	NI	PXI-4130:



			
For	more	information	about	the	NI	PXI-4130	specifications,	refer	to
Related	Documentation.



Theory	of	Operation
The	following	figure	represents	the	block	diagram	for	a	single	output
channel	on	the	NI	PXI-4130.

Each	output	channel	on	the	NI	PXI-4130	has	a	preregulation	switching
stage	and	a	linear	regulation	stage.	To	improve	efficiency	and	to	reduce
heat	dissipation	on	the	power	supply,	the	preregulation	stage	controls	the
voltage	level	across	the	control	element	in	the	linear	regulation	stage.
The	voltage	and	current	control	loops	work	together	through	the	linear
regulation	stage	to	provide	the	constant	voltage	mode	and	constant
current	mode.	In	constant	current	mode,	the	NI	PXI-4130	acts	as	a
precision	current	source.	Thus,	regardless	of	the	output	voltage,	the
current	through	the	load	is	held	constant	at	the	programmed	value.
The	isolated	output	(channel	1)	on	the	NI	PXI-4130	can	operate	from	the
PXI	chassis	power	(internal	power)	or	from	an	auxiliary	DC	power	supply.
When	operating	from	internal	power,	the	isolated	output	channels	are
restricted	to	lower	power	levels.	When	operating	from	an	auxiliary	power
source,	the	isolated	output	channel	can	increase	the	current	to	2	A,
delivering	a	maximum	of	40	W.



NI	PXI-4130	Front	Panel
The	following	figure	illustrates	the	NI	PXI-4130	front	panel.

Item Description
A Output	Connector,	Terminal	0 Channel	0	(0	to	+6	V)
B Output	Connector,	Terminal	1 GND
C Output	Connector,	Terminal	2 Channel	1	Output	HI	(±20	V)
D Output	Connector,	Terminal	3 Channel	1	Output	LO



E Output	Connector,	Terminal	4 Channel	1	Remote	Sense	-
F Output	Connector,	Terminal	5 Channel	1	Remote	Sense	+
G Auxiliary	Power	Input	Connector,

Terminal	0
Auxiliary	Power	Input	(+11	V	to
+15.5	V)

H Auxiliary	Power	Input	Connector,
Terminal	1

GND

I Auxiliary	Input	Fuse	Holder —
J Auxiliary	Input	Status	Indicator LED
K Channel	1	Sense	Status	Indicator LED
L Channel	1	Output	Status	Indicator LED
M Channel	0	Output	Status	Indicator LED



Status	Indicators
Status	indicators	on	the	front	panel	of	the	NI	PXI-4130	provide	feedback
about	device	operation.
Use	the	following	table	to	determine	the	state	of	an	output	channel	using
a	status	indicator.

Status
Indicator Channel	Output	State

(Off) Disabled
Green Enabled	(Constant	Voltage	mode)
Amber Enabled	(Constant	Current	mode)
Red Disabled	because	of	error,	such	as	an	overtemperature

condition

Use	the	following	table	to	determine	the	state	of	remote	sense	using	the
status	indicator.

Status	Indicator Channel	Sense	State
(Off) Local	Sense	Enabled
Green Remote	Sense	Enabled

Use	the	following	table	to	determine	the	state	of	the	auxiliary	power	input
using	the	status	indicator.

Status	Indicator Auxiliary	Power	Input	State
(Off) Auxiliary	power	input	disconnected	or	out	of	range
Green* Auxiliary	power	input	connected	and	within	range
*Does	not	indicate	that	the	auxiliary	power	is	in	use.	To	determine	if	the
NI	PXI-4130	is	using	auxiliary	power,	use	the	niDCPower	Power	Source
In	Use	property	or	the	NIDCPOWER_ATTR_POWER_SOURCE_IN_USE
attribute.

NIDCPowerProperties.chm::/pnidcpower_Power_Source_In_Use.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_POWER_SOURCE_IN_USE.html


Operating	the	Device
Expand	this	book	for	information	about	using	the	NI	PXI-4130.



Internal	and	Auxiliary	Power
When	drawing	internal	power	from	the	PXI	backplane,	channel	1	of	the
NI	PXI-4130	can	source	or	sink	up	to	2	W	of	output	power	with	a
maximum	current	of	300	mA.	The	following	figure	illustrates	the
maximum	capabilities	of	channel	1	when	operating	under	internal	power:

Note		Output	current	is	limited	to	100	mA	when	using	the	NI	PXI-
4130	Soft	Front	Panel.

If	your	application	requires	additional	current,	you	can	connect	an
auxiliary	DC	power	supply	capable	of	providing	11	V	to	15.5	V	and	≥60	W
to	increase	the	output	current	capability	of	this	channel	to	2	A.	NI	offers
the	APS-4100,	an	auxiliary	power	source	for	NI	DC	power	supplies.	Visit
ni.com	for	more	information.

Note		Channel	0	has	the	same	output	capabilities	under	internal
power	and	auxiliary	power.



Using	Auxiliary	Power
Complete	the	following	steps	to	connect	and	use	auxiliary	power:

1.	 Connect	a	11	V	to	15.5	V,	≥60	W	power	source	to	the	auxiliary
power	input	connector	on	the	NI	PXI-4130	front	panel.

2.	 Open	a	new	session	to	the	device.	NI-DCPower	automatically
uses	the	auxiliary	power	source	when	available.	To	override	this
feature,	use	the	niDCPower	Power	Source	property	or	the
NIDCPOWER_ATTR_POWER_SOURCE	attribute.

Tip		Use	the	niDCPower	Power	Source	In	Use	property	or
the	NIDCPOWER_ATTR_POWER_SOURCE_IN_USE
attribute	to	programmatically	determine	which	power
source	is	in	use.

NIDCPowerProperties.chm::/pnidcpower_Power_Source.html
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Resuming	Operation	After	a	Shutdown
In	case	of	auxiliary	power	loss	during	operation,	the	isolated	output
(channel	1)	is	disabled,	and	the	power	supply	is	shut	down	to	prevent
damage	to	the	NI	PXI-4130	and	the	load.	If	a	shutdown	occurs,	complete
the	following	steps	to	resume	operation:

1.	 Troubleshoot	the	failure.
2.	 Restore	auxiliary	power.
3.	 Reset	the	power	supply	using	the	niDCPower	Reset	VI	or	the

niDCPower_reset	function.
4.	 Reconfigure	the	SMU.

NIDCPowerVIRef.chm::/niDCPower_Reset.html
NIDCPowerCRef.chm::/cviniDCPower_Reset.html


Changing/Removing	Auxiliary	Power
Complete	the	following	steps	to	change	or	remove	auxiliary	power	from
the	NI	PXI-4130:

Tip		It	is	often	more	convenient	to	close	the	existing	session	and
open	a	new	session	to	the	device	when	managing	auxiliary	power
state	changes.

1.	 Disable	the	output	channels.
2.	 Disconnect/connect	the	auxiliary	power	source.
3.	 Reset	the	SMU	using	the	niDCPower	Reset	VI	or	the

niDCPower_reset	function.
4.	 Reconfigure	the	SMU.

NIDCPowerVIRef.chm::/niDCPower_Reset.html
NIDCPowerCRef.chm::/cviniDCPower_Reset.html


Cascading	Outputs
Caution		Do	not	exceed	60	VDC	from	any	terminal	to	ground
when	cascading	multiple	channels	on	the	NI	PXI-4130.

Because	channel	1	on	the	NI	PXI-4130	is	an	isolated	output,	it	can	be
cascaded	in	series	with	other	output	channels	to	generate	larger	output
voltages.	For	safety	reasons,	all	terminals	must	be	<60	VDC	from
ground.	Any	terminal	on	an	isolated	channel	can	be	connected	to	ground.
The	SMU	channel	on	the	NI	PXI-4130	cannot	be	used	in	parallel	with
other	channels	to	generate	larger	output	currents	because	it	is	a	four-
quadrant	supply	and	may	begin	to	sink	current	when	connected	in
parallel	to	another	channel	with	a	higher	voltage.

Note		Auxiliary	power	is	required	for	channel	1	output	greater	than
2	W	or	300	mA.	Refer	to	Internal	and	Auxiliary	Power	for	more
information	about	auxiliary	power.

Caution		The	NI	PXI-4130	does	not	provide	isolation	when	using
CH	0.



Measurement	Averaging
The	NI	PXI-4130	averages	measurement	samples	to	reduce	noise	and
improve	sensitivity.	You	can	set	the	number	of	samples	to	average
programmatically	using	the	niDCPower	Samples	To	Average	property	or
the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute.

Note		When	you	set	the	niDCPower	Samples	To	Average	property
or	the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute,	the
output	channel	measurements	might	move	out	of	synchronization.
Refer	to	the	niDCPower	Reset	Average	Before	Measurement
property	or	the
NIDCPOWER_ATTR_RESET_AVERAGE_BEFORE_MEASUREMENT
attribute	for	more	information	about	measurement	averaging	and
synchronization.

NIDCPowerProperties.chm::/pnidcpower_Samples_To_Average.html
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Determining	Measurement	Rate
Although	the	measurement	speed	of	the	NI	PXI-4130	is	3	kS/s	for	all
voltage	and	current	measurements,	the	measurement	rate	of	the	NI	PXI-
4130	can	vary	depending	on	the	setting	of	the	niDCPower	Samples	To
Average	property	or	the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE
attribute.
The	default	value	of	the	niDCPower	Samples	To	Average	property	and
the	NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	is	10.	As
expressed	in	the	following	equation,	the	NI	PXI-4130	returns	300
measurements	per	second	using	the	default	value.

	
If	no	measurement	averaging	is	used	(Samples	To	Average	=	1),	the
NI	PXI-4130	returns	3,000	measurements	per	second.
While	measuring	without	averaging	yields	the	fastest	measurement	rate,
noise	from	the	environment	(for	example,	the	50	Hz	or	60	Hz	noise
introduced	by	cabling)	increases	measurement	uncertainty.
Adjust	the	niDCPower	Samples	To	Average	property	or	the
NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	as	necessary	to
optimize	the	noise	performance	and	measurement	rate	for	your
application.

Note		Measurement	rate	refers	only	to	the	hardware	measurement
rate	and	does	not	include	software	latency.



Rejecting	Noise
If	you	know	the	noise	frequency,	you	can	reject	it	from	the	signal.	To
determine	the	number	of	measurements	necessary	to	reject	noise	from	a
signal,	divide	the	measurement	speed	of	the	NI	PXI-4130	by	a	full
wavelength	cycle	of	noise.
Example	1
To	reject	60	Hz	noise	frequency	from	a	signal,	average	50	measurements
(3	kHz/60	Hz	=	50).
Example	2
To	reject	50	Hz	noise	frequency	from	a	signal,	average	60	measurements
(3	kHz/50	Hz	=	60).

Tip		Set	the	niDCPower	Samples	To	Average	property	or	the
NIDCPOWER_ATTR_SAMPLES_TO_AVERAGE	attribute	to	300,	an
even	multiple	of	both	60	kHz	and	50	kHz,	to	actively	reject	both
noise	frequencies.



Output	Capacitance	Selection
A	switchable	output	capacitor	can	be	enabled	on	channel	1	of	the	NI	PXI-
4130	to	help	the	device	operate	normally	under	unstable	conditions.
Enabling	this	output	capacitor	can	also	be	useful	in	filtering	ripple	in
higher	current	ranges.	Use	the	niDCPower	Output	Capacitance	property
or	the	NIDCPOWER_ATTR_OUTPUT_CAPACITANCE	attribute	to	enable
or	disable	the	capacitor.

Note		Changing	the	output	capacitance	requires	channel	1	to	be
disabled,	and	may	cause	a	glitch	in	the	device	output.

Output	Capacitance	Setting Output	Capacitance
Low 10	nF
High 6.8	μF

NIDCPowerProperties.chm::/pnidcpower_Output_Capacitance.html
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Instability	in	the	SMU	Output	on	Low	Capacitance	Setting
When	using	the	SMU	with	the	Low	Capacitance	setting,	the	combination
of	output	currents	200	mA	and	above,	inductive	loads	greater	than	2	μH,
and	resistances	below	1	Ω	can	induce	instabilities	in	the	device	output.
The	following	list	includes	examples	where	these	instabilities	may	be
found:

Driving	current	sense	or	power	resistors
Wirewound	loads
Transformers
Shorted	leads	greater	than	15	cm
Any	of	the	above	combined	with	remote	sense

In	these	cases,	using	the	High	Capacitance	setting	dramatically	reduces
the	chances	of	observing	resonance	or	oscillations	between	the	SMU
and	the	load.	Alternatively,	you	can	provide	an	external	capacitance	at
the	load.	NI	recommends	starting	with	a	capacitance	of	at	least	0.1	μF.
More	than	10	μF	should	not	be	necessary,	but	can	be	used	if	required.
Remember	that	large	capacitances	(>0.1	μF)	result	in	a	slower	output
response.	Refer	to	Load	Considerations	for	more	information	about
capacitive	loads.



Related	Topics
Noise
NI	PXI-4130	Source	Stability	Under	Reactive	Loads



Power	Measurements
NI-DCPower	can	be	used	to	measure	power	flowing	into	or	out	of	the
NI	PXI-4130.	Use	the	Measure	Multiple	VI	to	measure	both	current	and
voltage	for	the	channel	you	want	to	make	the	power	measurement	on.	Be
aware	that	these	two	measurements	do	not	occur	simultaneously,	and	as
much	as	250	μs	may	elapse	between	the	two	measurements.	If	the
voltage	and	current	have	the	same	polarity	(both	positive	or	both
negative),	the	NI	PXI-4130	is	sourcing	power.	If	they	have	opposite
polarities	(one	positive	and	one	negative),	the	NI	PXI-4130	is	sinking
power.

niDCPowerVIRef.chm::/niDCPower_Measure_Multiple.html


Protection
The	output	channels	and	the	auxiliary	power	input	of	the	NI	PXI-4130	are
protected	against	overcurrent,	overvoltage,	inverse	voltage	(CH	0	only),
and	overtemperature	conditions.



Output	Channel	Protection
Both	output	channels	on	the	NI	PXI-4130	are	current-limited,	and
channel	0	has	a	user-replaceable	fuse.	In	the	event	of	an	overcurrent,
overvoltage,	or	inverse	voltage	condition,	this	fuse	may	blow	to	protect
the	NI	PXI-4130	and	the	load.	When	its	fuse	is	blown,	channel	0	can
source	only	a	few	milliamperes	of	current	regardless	of	the	programmed
current.

Caution		Channel	0	can	withstand	the	application	of	an	external
voltage	up	to	16	V.	Applying	an	external	voltage	>16	V	can
damage	the	output	channel.

Caution		Channel	1	can	withstand	the	application	of	an	external
voltage	up	to	50	V.	Applying	an	external	voltage	>50	V	can
degrade	or	damage	the	output	channel.

In	the	event	of	an	overtemperature	condition	(that	is,	the	enclosure	or
component	temperatures	exceed	safe	operating	limits),	the	thermal
shutdown	circuits	on	the	NI	PXI-4130	disable	the	output	channel	that
indicated	the	failure	condition.	When	disabled,	an	output	channel	can
only	be	reset	programmatically	after	the	failure	condition	is	cleared.



Auxiliary	Input	Protection
The	auxiliary	power	input	of	the	NI	PXI-4130	can	accept	voltages	from
11	V	to	15.5	V.	Applying	a	voltage	below	11	V	or	above	15.5	V	disables
the	auxiliary	power	input.
In	the	event	of	an	overvoltage	condition	(that	is,	applying	voltages	>20	V
to	the	auxiliary	power	input),	crowbar	protection	is	enabled.	Crowbar
protection	shunts	the	auxiliary	power	input	to	ground.
In	the	event	of	an	overcurrent	(>6.3	A)	or	an	inverse	voltage	condition,
the	auxiliary	power	input	fuse	may	blow	to	protect	the	NI	PXI-4130	and
the	load.	You	can	use	the	niDCPower	Auxiliary	Power	Source	Available
property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	to	troubleshoot	the	auxiliary	power	input	fuse.

NIDCPowerProperties.chm::/pnidcpower_auxiliary_power_source_available.html
NIDCPowerCRef.chm::/NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE.html


Related	Topics
Replacing	a	Fuse
Troubleshooting



Pulsed	Operation
Note		Pulsed	operation	refers	only	to	channel	1	of	the	NI	PXI-
4130.

When	sourcing	pulses	with	currents	greater	than	500	mA,	the	device
power	dissipation	increases	drastically	if	the	duration	of	these	pulses	is
below	10	milliseconds.	This	additional	power	may	overheat	the	NI	PXI-
4130	components	and	thus	engage	the	thermal	protection	forcing	a
channel	shutdown.
When	sinking	power	pulses,	the	limiting	parameter	is	the	average	power
being	dissipated	by	the	device.	The	maximum	average	power	dissipation
allowed	is	10	W	for	ambient	temperatures	less	than	30°C.	For	higher
ambient	temperatures,	the	maximum	average	power	has	to	be	derated
by	a	factor	of	0.2	W	per	degree	Celsius.

Caution		Exceeding	the	recommended	maximum	power	sinking
limits	may	result	in	undesired	interruption	of	the	SMU	operation
and	excessive	stress	to	the	components	that	could	result	in
damage	to	the	device.

If	the	duration	of	the	pulses	is	below	10	milliseconds,	the	channel	may	be
forced	to	shut	down	because	of	an	overtemperature	condition.	Please
refer	to	the	following	graph	to	verify	the	conditions	at	which	the	SMU
operates	without	interruption.



Note		This	graph	is	only	valid	up	to	an	ambient	temperature	of
30°C.	For	higher	ambient	temperatures,	derate	according	to	the
device	specifications.

Note		For	pulses	longer	than	1	second,	the	operation	is	considered
to	be	continuous	and	the	peak	power	should	be	limited	instead	of
average	power.

Hot	Surface		Do	not	touch	the	outer	shield	of	the	NI	PXI-4130	as	it
may	become	very	hot	during	an	overtemperature	condition.



Related	Topics
NI	PXI-4130	Thermal	Protections	and	Precautions
NI	PXI-4130	Troubleshooting



Range	Considerations
It	is	not	possible	to	change	the	measurement	range	for	the	NI	PXI-4130
independently	of	the	output	range.	The	measurement	range	is	implicitly
selected	based	on	the	configured	output	range.	The	selected
measurement	range	is	large	enough	to	measure	any	voltage	or	current
possible	in	the	configured	output	range.
The	voltage	output	can	be	set	to	any	value	between	0%	and	100%	of	the
active	range	using	the	niDCPower	Configure	Voltage	Level	VI	or	the
niDCPower_ConfigureVoltageLevel	function,	or	the	niDCPower	Configure
Voltage	Limit	VI	or	the	niDCPower_ConfigureVoltageLimit	function.	Current
output	can	be	set	to	any	value	between	2%	and	100%	of	the	active	range
using	the	niDCPower	Configure	Current	Level	VI	or	the
niDCPower_ConfigureCurrentLevel	function,	or	the	niDCPower	Configure
Current	Limit	VI	or	the	niDCPower_ConfigureCurrentLimit	function.
Measurements	for	both	voltage	and	current	can	be	made	from	0%	to
105%	of	the	active	range	using	the	niDCPower	Measure	Multiple	VI	or
the	niDCPower_MeasureMultiple	function.	Refer	to	Overranging	for	general
information	about	enabling	overranging	in	software.

niDCPowerVIRef.chm::/niDCPower_Configure_Voltage_Level.html
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Overranging
Enabling	overranging	for	a	particular	channel	of	the	NI	PXI-4130	extends
current	and	voltage	output	capabilities	up	to	105%	and	current	setpoints
down	to	1%	for	the	output	range	(without	overranging,	valid	output	values
are	between	2%	and	100%	of	the	current	output	range).	Measurements
in	any	given	range	may	be	made	up	to	105%	of	the	range	by	default
without	enabling	overranging.
An	auxiliary	power	supply	providing	at	least	12	V	at	the	input	terminals
should	be	used	when	enabling	overranging	for	channel	1.	Refer	to
Ranges	for	more	information	about	enabling	or	disabling	overranging	for
a	particular	channel.



Considerations	When	Making	Range	Changes
Using	delayed	configuration	mode,	changes	in	voltage	and	current	levels
occur	simultaneously	when	the	device	is	initiated.	These	changes	do	not
occur	at	the	same	time	if	there	is	a	current	range	change	involved.	If	the
current	range,	current	limit,	and	voltage	level	are	all	changed	within	the
same	delayed	configuration,	the	current	range	and	current	limit	change
occur	first	immediately	followed	by	the	voltage	level	change.



Disabled	State
When	channel	1	is	disabled,	it	is	actively	maintaining	0	V	with	a	current
limit	of	20	mA.	If	a	device	capable	of	sourcing	power	is	connected	to
channel	1	while	the	channel	is	disabled,	the	channel	begins	to	sink	power
with	a	current	limit	of	20	mA.

Note		All	channels	on	the	NI	PXI-4130	power	on	in	the	disabled
state.



Related	Topics
Ranges



Replacing	a	Fuse
Refer	to	the	following	table	for	user-replaceable	fuse	ratings	and
manufacturer	information	for	the	NI	PXI-4130.

Input/Output Fuse	Rating Description
Recommended

Manufacturer	Part
Number

Channel	0
(F1)

F	1.5	A	125	V User-replaceable
chip	fuse

Littelfuse	045301.5

Auxiliary
Power	Input

T	6.3	A	L	250	V User-replaceable
5	x	20	mm	glass
fuse

Littelfuse	21806.3

To	replace	a	fuse	on	the	NI	PXI-4130,	complete	the	following	steps:
1.	 Shut	down	the	chassis.
2.	 Disconnect	all	output	and	auxiliary	power	connections.
3.	 Remove	the	NI	PXI-4130	from	the	chassis.
4.	 Identify	the	fuse	you	want	to	replace	using	the	following	figure.

1 Output	Channel	Fuse	(Channel	0)
2 Auxiliary	Input	Fuse



5.	 Remove	the	fuse.
(Output	channel	fuse)	Using	small	pliers,	gently	pull	the
fuse	to	release	it	from	the	fuse	holder.
(Auxiliary	input	fuse)

a.	 Using	a	flathead	screwdriver,	turn	the	fuse	holder
cap	counter-clockwise	to	release	it	from	the	NI	PXI-
4130	front	panel.

b.	 Gently	pull	the	auxiliary	power	input	fuse	to	release
it	from	the	fuse	holder	cap.

6.	 Install	the	replacement	fuse.
(Output	channel	fuse)	Using	small	pliers,	gently	place	the
replacement	fuse	into	the	fuse	holder.
(Auxiliary	input	fuse)	Slide	the	replacement	fuse	into	the
fuse	holder	cap,	and	screw	the	cap	clockwise	to	replace	it
on	the	NI	PXI-4130	front	panel.



Source	Stability	Under	Reactive	Loads
In	Constant	Voltage	mode,	the	NI	PXI-4130	remains	stable	for	most
loads,	even	in	the	presence	of	low-equivalent	series	resistance	(ESR)
capacitors.	However,	when	operating	in	Constant	Current	mode,
particularly	in	higher	current	ranges,	some	inductive	loads	may	cause	the
NI	PXI-4130	source	to	become	unstable,	especially	during	high	current
operation.	If	the	source	becomes	unstable,	an	oscillating	or	unregulated
behavior	can	be	observed	across	the	output	terminals.	This	situation
yields	excessive	noise	in	the	measurement,	erratic	behavior,	or	thermal
shutdown.
After	noticing	any	abnormalities,	you	can	verify	the	behavior	of	your
device	by	inspecting	the	voltage	across	the	output	terminals	with	an
oscilloscope	or	a	digitizer.	To	troubleshoot	this	issue,	use	the	niDCPower
Output	Capacitance	property	or	the	niDCPower_ATTR_Output_Capacitance
attribute	to	enable	or	disable	the	capacitor.	For	more	information	about
operating	your	device	under	unstable	conditions,	refer	to	Output
Capacitance	Selection.

niDCPowerProperties.chm::/pniDCPower_Output_Capacitance.html
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Thermal	Protections	and	Precautions
Both	channels	of	the	NI	PXI-4130	are	protected	against	excessive
temperatures	and	shut	down	in	the	presence	of	excessive	heat.
During	normal	sourcing	operation	on	channel	1	(up	to	40	W	output),	the
thermal	protection	should	not	engage	over	the	rated	ambient	temperature
range	of	the	device.	Also,	sinking	power	levels	within	the	rated
specifications	of	the	device	should	not	trigger	the	thermal	protection
when	the	device	is	within	the	ambient	temperature	range.

Hot	Surface		Do	not	touch	the	outer	shield	of	the	NI	PXI-4130	as	it
may	become	very	hot	during	an	overtemperature	condition.

Thermal	protection	for	channel	1	may	also	become	engaged	if	the	output
becomes	unstable	because	of	inductive	loads	in	the	highest	current
range.	If	you	are	operating	the	NI	PXI-4130	within	the	rated	specifications
and	the	thermal	protection	is	engaging,	refer	to	Source	Stability	Under
Reactive	Loads	and	Output	Capacitance	Selection	to	determine	if
instability	may	be	a	factor	in	overtemperature	operation	of	your	device.



Related	Topics
NI	PXI-4130	Pulsed	Operation
NI	PXI-4130	Troubleshooting



Transients	During	Power-Up	and	Power-Down
Attention	must	be	paid	to	the	setup	and	operation	of	your	NI	PXI-4130.
Transients	may	appear	across	the	terminals	(typically	<1	V)	during
power-up,	power-down,	and	when	loading	the	device	driver.
To	minimize	the	risk	of	damage	to	sensitive	devices,	NI	recommends	that
all	power	supplies	and	SMU	connections	are	disconnected	while
performing	any	of	the	above	operations.
In	case	of	chassis	power	failure,	transients	may	appear	across	the	output
terminals.	Consider	employing	an	uninterruptible	power	supply	system	to
avoid	damage	to	extremely	sensitive	devices.



Troubleshooting
If	the	NI	PXI-4130	is	operating	incorrectly,	perform	the	following	actions:

Verify	that	the	hardware	and	software	are	properly	installed.
Verify	that	all	connections,	including	the	front	panel	connections	to
the	output	channels	and	auxiliary	power	supply	(if	applicable),	are
secure.
Verify	that	the	output	channels	are	enabled.	If	necessary,	use	the
niDCPower	Configure	Output	Enabled	VI	or	the
niDCPower_ConfigureOutputEnabled	function	to	enable	the	output
channels.
Inspect	all	fuses,	and	verify	that	each	is	in	working	condition.	If
necessary,	replace	any	blown	fuses.

Tips		Although	blown	output	channel	and	auxiliary	power	input
fuses	are	not	software	detectable,	you	can	use	the
niDCPower	Auxiliary	Power	Source	Available	property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	to	troubleshoot	the	auxiliary	power	input	fuse.	

If	you	suspect	a	blown	output	channel	fuse,	keep	in	mind	that	an
output	channel	with	a	blown	fuse	can	source	only	a	few
milliamperes	of	current	regardless	of	the	programmed	current
limit.

Run	a	self-test	on	the	NI	PXI-4130	using	the	niDCPower	Self	Test
VI	or	the	niDCPower_self_test	function.	If	the	NI	PXI-4130	is
damaged,	contact	NI	for	information	about	repair.
Verify	that	the	output	is	stable	when	operating	with	reactive	loads.
Refer	to	Source	Stability	Under	Reactive	Loads	and	Output
Capacitance	Selection	for	more	information	about	stable	device
operation.
Check	for	any	error	conditions	that	may	exist	in	the	output
channels	such	as	thermal	shutdown.	If	applicable,	clear	the	error
condition	by	resetting	the	device.
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Integration	and	System	Considerations
Expand	this	book	for	information	related	to	integrating	the	NI	power
supplies	and	SMUs	with	other	devices	and	environments.



Environment
NI	power	supplies	and	SMUs	are	designed	to	operate	in	any	PXI-
compliant	chassis	at	an	ambient	temperature	between	0	ºC	and	55	ºC
and	at	a	relative	humidity	up	to	90%.
For	best	performance,	observe	the	following	recommendations:

Keep	the	power	supply	or	SMU	clean	and	free	from	contaminants.
Use	a	chassis	that	has	a	well-designed	cooling	system.	All	NI	PXI
chassis	meet	this	requirement.
Note		To	ensure	that	the	power	supply	or	SMU	operates	at	peak
performance	within	the	PXI	chassis,	refer	to	PXI	Chassis
Recommendations.

Operating	under	high	humidity	(>90%)	or	dusty	conditions	may	cause
increased	leakage	between	circuit	components	and	can	result	in
additional	measurement	errors.



PXI	Chassis	Recommendations
NI	power	supplies	and	SMUs	are	designed	to	operate	in	any	PXI-
compliant	chassis.	Temperature	rise	of	the	device	can	vary	with	slot
position	in	the	chassis.	Observe	the	following	recommendations	to
minimize	this	temperature	variation	and	to	ensure	normal	operating
conditions	for	your	device:

Perform	routine	maintenance	of	the	chassis	cooling	fan	filters	to
assure	continuous	cooling	effectiveness	and	to	keep	dust	off	of	the
device	components.	NI	recommends	cleaning	the	chassis	fan
filters	at	a	maximum	interval	of	six	months	and	keeping	the	chassis
environment	clean	to	minimize	the	amount	of	dust	that	enters	the
chassis.	For	more	information	about	cleaning	the	chassis	fan
filters,	refer	to	the	documentation	for	your	chassis.
Install	PXI	filler	panels	in	all	empty	slots.
Verify	that	the	PXI	chassis	fans	that	provide	forced	air	remain
unobstructed	to	allow	for	proper	cooling	of	the	PXI	chassis,
devices,	and	controller.



NI-DCPower	Soft	Front	Panel
Use	the	NI-DCPower	Soft	Front	Panel	(SFP)	to	configure	and	enable
channels,	monitor	voltage	and	current	measurements,	and	test	the
functionality	of	an	NI	DC	power	supply	or	SMU.	To	launch	the	NI-
DCPower	SFP,	navigate	to	Start»All	Programs»National
Instruments»NI-DCPower»NI-DCPower	Soft	Front	Panel.

When	using	the	NI-DCPower	SFP,	you	can	make	the	following
selections,	based	upon	the	measurement	mode	and	functionality	your
application	requires:

Select	the	Output	Function	you	want	to	use.

	

When	using	the	DC	Voltage	output	function,	use	the	Voltage	Level
and	Current	Limit	controls	to	set	the	voltage	level	and	the	current
limit	for	a	channel.

	



When	using	the	DC	Current	output	function,	use	the	Current	Level
and	Voltage	Limit	controls	to	set	the	current	level	and	the	voltage
limit	for	a	channel.

	

If	applicable,	select	a	voltage	and/or	current	range	for	the	channel
from	the	Range	drop-down	listboxes.

	

Available	ranges	depend	upon	the	power	supply	or	SMU	and	the
selected	function	you	are	using.	The	Range	drop-down	listboxes
display	a	list	of	available	ranges	for	each	function	and	device.
If	you	are	using	a	device	with	remote	sense	capabilities,	you	can
use	the	Sense	drop-down	listbox	to	select	either	Local	or	Remote
sense.

	

After	you	have	configured	the	channel,	click	Output	Enabled	to
enable	the	channel	and	begin	supplying	power.



	

As	power	is	supplied,	the	NI-DCPower	SFP	displays	voltage	and	current
measurements.

	

Note		When	a	channel	is	operating	in	Constant	Current	mode,	the
letters	CC	light	up	in	the	display.	When	a	channel	is	operating	in
Constant	Voltage	mode,	the	letters	CV	light	up	in	the	display.
When	the	channel	is	operating	at	the	compliance	limit,	Cmpl	lights
up	in	the	display.	For	more	information	about	the	compliance	limit,
refer	to	Compliance.
When	you	are	finished	with	your	measurements,	select	File»Exit
to	close	the	NI-DCPower	SFP.



Programming	with	NI-DCPower
NI-DCPower,	an	Interchangeable	Virtual	Instrument	(IVI)–compliant
instrument	driver,	is	included	with	your	NI	power	supply	or	SMU	and
communicates	with	all	NI	programmable	power	supplies	and	SMUs.	NI-
DCPower	features	a	set	of	operations	and	properties	that	exercise	the
functionality	of	the	power	supply	or	SMU	and	includes	an	interactive	soft
front	panel.



Examples
Refer	to	Getting	Started	to	begin	controlling	your	power	supply	with	NI-
DCPower.	Refer	to	Examples	for	LabVIEW,	LabWindows/CVI,	and	Visual
Basic	example	locations.



Getting	Started
This	topic	explains	how	to	begin	using	NI-DCPower	with	your	application
development	environment	(ADE),	lists	any	files	to	include	in	your
application,	and	mentions	considerations	for	each	ADE.
To	successfully	build	your	application,	you	must	have	NI-DCPower	and
one	of	the	following	ADEs	installed:

LabVIEW
LabWindows/CVI
Visual	C++
Visual	Basic

You	can	use	the	NI-DCPower	Express	VI	to	quickly	begin	using	NI-
DCPower	in	LabVIEW.

NIDCPowerVIRef.chm::/niDCPower_Express.html


Using	NI-DCPower	in	LabVIEW
This	topic	assumes	that	you	are	using	LabVIEW	to	manage	your	code
development	and	that	you	are	familiar	with	the	ADE.
To	develop	an	NI-DCPower	application	in	LabVIEW,	follow	these	general
steps:

1.	 Open	an	existing	or	new	LabVIEW	VI.
2.	 Locate	the	NI-DCPower	VIs.

(LabVIEW	8.0	or	later)	From	the	Functions	palette,	select
Measurement	I/O»NI-DCPower.
(LabVIEW	7.x)	From	the	Functions	palette,	select	All
Functions»Instrument	I/O»Instrument	Drivers»NI-
DCPower.

3.	 Select	the	VIs	that	you	want	to	use,	and	drop	them	on	the	block
diagram	to	build	your	application.

Example	Programs
You	can	use	the	LabVIEW	Example	Finder	to	search	or	browse
examples.	NI-DCPower	examples	are	classified	by	keyword,	so	you	can
search	for	a	particular	device	or	measurement	function.
To	browse	the	NI-DCPower	examples	available	in	LabVIEW,	launch
LabVIEW,	click	Find	Examples,	and	navigate	to	Hardware	Input	and
Output»Modular	Instruments»NI-DCPower.
For	additional	information	regarding	NI-DCPower	examples,	refer	to
Examples.



Considerations	for	Using	the	LabVIEW	Real-
Time	Module
To	develop	an	NI-DCPower	application	in	the	LabVIEW	Real-Time
Module,	follow	the	same	steps	used	for	developing	any	application	in	the
LabVIEW	Real-Time	Module,	with	the	addition	of	using	the	NI-DCPower
LabVIEW	VIs.

Note		Applications	running	NI-DCPower	in	the	LabVIEW	Real-
Time	Module	on	an	RT	target	may	be	compromised	and/or	slow	at
64	MB	of	memory.

NIDCPowerVIRef.chm::/NIDCPowerVIRef.html


Hardware	Support

NI-DCPower	supports	all	National	Instruments	power	supplies	and	SMUs
on	RT	targets.



Unsupported	Features
When	using	NI	power	supplies	and	SMUs	with	the	LabVIEW	Real-Time
Module,	the	following	features	are	not	supported:

External	calibration
NI-DCPower	Soft	Front	Panel	(SFP)
Express	VIs



Related	Documentation
For	configuration	instructions	for	remote	systems,	refer	to	the
Remote	Systems	Help	in	Measurement	&	Automation	Explorer
(MAX)	by	selecting	Help»Help	Topics»Remote	Systems	in	MAX.
For	more	information	about	the	LabVIEW	Real-Time	Module,	refer
to	the	LabVIEW	Real-Time	Module	User	Manual	at
ni.com/manuals.
For	additional	troubleshooting	and	support	information,	refer	to	the
LabVIEW	Real-Time	Support	main	page	at
ni.com/support/labview/real-time.
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Using	NI-DCPower	in	LabWindows/CVI
This	topic	assumes	that	you	are	using	the	LabWindows/CVI	ADE	to
manage	your	code	development	and	that	you	are	familiar	with	the	ADE.
To	develop	an	NI-DCPower	application	in	LabWindows/CVI,	follow	these
general	steps:

1.	 Open	an	existing	or	new	project	file.
2.	 Load	the	NI-DCPower	function	panel,	nidcpower.fp,	at

<IVI>\Drivers\niDCPower.
3.	 Use	the	function	panel	to	navigate	the	function	hierarchy	and

generate	function	calls	with	the	proper	syntax	and	variable	values.
Example	Programs
LabWindows/CVI	users	can	use	the	NI	Example	Finder	to	search	or
browse	examples.	NI-DCPower	example	are	classified	by	keyword,	so
you	can	search	for	a	particular	device	or	measurement	function.	To
browse	the	NI-DCPower	examples	available	in	LabWindows/CVI,	launch
LabWindows/CVI,	select	Help»Find	Examples,	and	navigate	to
Hardware	Input	and	Output»Modular	Instruments»NI-DCPower.
For	additional	information	regarding	NI-DCPower	examples,	refer	to
Examples.



Using	NI-DCPower	in	Visual	C++
This	topic	assumes	that	you	are	using	the	Microsoft	Visual	C++	ADE	to
manage	your	code	development	and	that	you	are	familiar	with	the	ADE.
To	develop	an	NI-DCPower	application	in	Visual	C++,	follow	these
general	steps:

1.	 Open	an	existing	or	new	Visual	C++	project.
2.	 Create	source	files	of	type	.c	(C	source	code)	or	.cpp	(C++	source

code)	and	add	them	to	the	project.	Make	sure	that	you	include	the
NI-DCPower	header	file,	nidcpower.h,	in	your	source	code	files	as
follows:	#include	"nidcpower.h".

3.	 Specify	the	directory	that	contains	the	NI-DCPower	header	file
under	the	Preprocessor»Additional	include	directories	settings
in	your	compiler—for	Visual	C++	6.0	these	files	are	under
Project»Settings»C/C++.	The	NI-DCPower	header	files	are
located	at	<IVI>\Include.

4.	 Add	the	NI-DCPower	import	library	nidcpower.lib	to	the	project
under	Link»General»Object/Library	Modules.	The	NI-DCPower
import	library	files	are	located	in	the	<IVI>\Lib\msc	directory	within
your	NI-DCPower	directory.

5.	 Add	NI-DCPower	function	calls	to	your	application.
6.	 Build	your	application.

String	Passing
To	pass	strings,	pass	a	pointer	to	the	first	element	of	the	character	array.
Be	sure	that	the	string	is	null-terminated.
Parameter	Passing
By	default,	C	passes	parameters	by	value.	Remember	to	pass	pointers	to
variables	when	you	need	to	pass	by	address.



Using	NI-DCPower	in	Visual	Basic
This	topic	assumes	that	you	are	using	the	Microsoft	Visual	Basic	ADE	to
manage	your	code	development	and	that	you	are	familiar	with	the	ADE.
To	develop	an	NI-DCPower	application	in	Visual	Basic,	follow	these
general	steps:

1.	 Open	an	existing	or	new	Visual	Basic	project.
2.	 Create	files	necessary	for	your	application:	.frm	(form	definition

and	event	handling	code),	.bas	(Visual	Basic	generic	code
module),	or	.cls	(Visual	Basic	class	module).	Add	these	files	to	the
project.

3.	 Add	a	reference	to	the	National	Instruments	DCPower	Library
(NIDCPower),	which	is	part	of	the	NI-DCPower	DLL.	In	Visual
Basic	6.0,	select	the	Project»References	menu	option	and	NI-
DCPower.	If	you	do	not	see	NI-DCPower	listed	there,	use	the
Browse	button	and	browse	to	<IVI>\bin\nidcpower_32.dll.

4.	 Use	the	Object	Browser	<F2>	to	find	function	prototypes	and
constants.

5.	 Add	NI-DCPower	function	calls	to	your	application.
6.	 Click	Run.

Example	Programs
For	additional	information	regarding	NI-DCPower	examples,	refer	to
Examples.	To	load	an	example	project	with	Visual	Basic	6.0,	select
File»Open	Project,	then	select	the	.vbp	file	of	your	choice.
String	Passing
In	Visual	Basic,	variables	of	data	type	String	do	not	need	special
modifications	to	be	passed	to	NI-DCPower	functions.	Visual	Basic
automatically	appends	a	null	character	to	the	end	of	a	string	before
passing	it	(by	reference,	because	strings	cannot	be	passed	by	value	in
Visual	Basic)	to	a	procedure	or	function.
Parameter	Passing
By	default,	Visual	Basic	passes	parameters	by	reference.	Prepend	the
ByVal	keyword	if	you	need	to	pass	by	value.



Programming	Flow
To	program	an	NI	power	supply	or	SMU,	complete	the	following	steps:

1.	 Open	a	session.
2.	 Configure	the	device	for	your	application.
3.	 Measure	and	Query.	(Optional)
4.	 Close	the	session.



Opening	a	Session
To	open	a	session,	use	the	niDCPower	Initialize	or	niDCPower	Initialize
With	Options	VI	or	the	niDCPower_init	or	niDCPower_InitWithOptions
function.

Note		When	you	execute	the	niDCPower	Initialize	VI	or	the
niDCPower_init	function	with	the	reset	device	parameter	set	to
TRUE	(default	value),	a	new	session	is	opened	and	the	device	is
automatically	initiated.	Upon	initiation,	the	default	session
attributes	are	immediately	applied	to	the	device.	To	override	this
feature,	execute	the	niDCPower	Initialize	VI	or	the	niDCPower_init
function	with	the	reset	device	parameter	set	to	FALSE.
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Configuring	the	Device
NI-DCPower	has	two	configuration	modes—Immediate	mode	and
Delayed	Configuration	mode.	Configuration	modes	determine	how
configuration	calls	are	applied	to	the	device.	In	Immediate	mode,	every
configuration	call	is	immediately	applied	to	the	device.	In	Delayed
Configuration	mode	all	configuration	changes	are	cached,	and	the	device
continues	to	operate	in	its	last	configured	state	until	you	execute	the
niDCPower	Initiate	VI	or	the	niDCPower_Initiate	function.
The	first	configuration	or	measurement	call	in	a	session	not	preceded	by
a	call	to	the	niDCPower	Abort	VI	or	the	niDCPower_Abort	function	places
the	device	in	Immediate	mode.
Execute	the	niDCPower	Initiate	VI	or	the	niDCPower_Initiate	function	to
place	the	device	in	Immediate	mode.	Execute	the	niDCPower	Abort	VI	or
the	niDCPower_Abort	function	to	place	the	device	in	Delayed
Configuration	mode.

Note		When	you	execute	the	niDCPower	Initialize	VI	or	the
niDCPower_init	function	with	the	reset	device	parameter	set	to
TRUE	(default	value),	a	new	session	is	opened	in	Immediate
mode.	Refer	to	Opening	a	Session	for	more	information	about
opening	sessions.

You	can	also	use	the	niDCPower	Initiate	VI	or	the	niDCPower_Initiate
function	and	the	niDCPower	Abort	VI	or	the	niDCPower_Abort	function	to
move	between	configuration	modes.	For	example,	execute	the
niDCPower	Abort	VI	or	the	niDCPower_Abort	function	to	move	from
Immediate	mode	to	Delayed	Configuration	mode.	To	apply	cached
configuration	changes	to	the	device,	execute	the	niDCPower	Initiate	VI	or
the	niDCPower_Initiate	function.

Tip		In	Immediate	mode,	configuration	calls	to	multiple	channels
are	performed	sequentially,	not	simultaneously.	Use	the	Delayed
Configuration	mode	to	simultaneously	configure	multiple	attributes
on	one	or	more	channels.

Attribute	values	do	not	persist	between	sessions.	If	you	close	a	session
and	open	a	new	one,	all	attributes	assume	their	default	values;	however,
the	default	values	are	not	committed	to	the	device	until	the	session
enters	the	Immediate	mode.
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Tip			To	open	a	session	and	leave	the	device	in	its	existing
configuration	without	passing	through	a	transitional	output	state,
execute	the	niDCPower	Initialize	VI	or	the	niDCPower_init	function
with	the	reset	device	parameter	set	to	FALSE,	and	then
immediately	execute	the	niDCPower	Abort	VI	or	the
niDCPower_Abort	function.	To	apply	a	new	configuration	without
disrupting	the	output	channels	of	the	device,	configure	the	device
in	Delayed	Configuration	mode	as	in	the	previous	session
changing	only	the	desired	settings,	and	then	execute	the
niDCPower	Initiate	VI	or	the	niDCPower_Initiate	function.



Closing	a	Session
Use	the	niDCPower	Close	VI	or	the	niDCPower_close	function	to	close	a
session.
When	you	close	a	session	to	a	device,	the	device	continues	to	operate	in
its	last	configured	state.	If	you	close	the	session	while	the	output
channels	of	the	device	are	enabled	and	actively	sourcing	or	sinking
power,	the	device	continues	to	source	or	sink	power	until	it	is	disabled	or
reset.
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Using	Properties	and	Attributes
NI-DCPower	contains	high-level	VIs	and	functions	that	set	most	of	the
device	properties	and	attributes.
Refer	to	NI-DCPower	LabVIEW	Reference	or	NI-DCPower	Function
Reference	for	a	complete	a	listing	of	the	available	properties	and
attributes	in	NI-DCPower.
Some	properties	and	attributes	are	not	accessible	through	the	high-level
VIs	and	functions.	The	values	for	these	properties	and	attributes	must	be
set	using	the	appropriate	property	or	attribute.
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Accessing	Properties
In	LabVIEW,	properties	are	accessed	through	the	NI-DCPower	property
node.	To	access	properties	in	LabVIEW,	complete	the	following	steps:

1.	 Open	a	VI.
2.	 In	the	block	diagram	view,	navigate	to	the	NI-DCPower	palette.

(LabVIEW	8.0	or	later)	From	the	Functions	palette,	select
Measurement	I/O»NI-DCPower.
(LabVIEW	7.x)	From	the	Functions	palette,	select	All
Functions»Instrument	I/O»Instrument	Drivers»NI-
DCPower.

3.	 Drag	and	drop	the	property	node	icon	to	the	block	diagram.
4.	 Left-click	the	property	node,	and	select	the	property	that	you	want

to	use.
5.	 To	add	additional	properties,	resize	the	property	node.	To	resize

the	property	node,	drag	the	resizing	handle	at	the	top	or	bottom	of
the	node	and	release	the	mouse	button.
Note		To	access	a	channel-based	property,	you	must	pass	an
Active	Channel.	The	Active	Channel	is	listed	first	in	the	property
node.	To	access	a	device-based	property,	do	not	pass	an	Active
Channel	or	pass	an	empty	string.



Accessing	Attributes
In	C	and	Visual	Basic,	attributes	are	accessed	with	the	Get	Attribute	and
Set	Attribute	functions.	Get	and	Set	Attribute	functions	exist	for	each
supported	data	type	in	NI-DCPower.



Setting	Properties	and	Attributes	Before
Reading	Them
Properties	and	attributes	are	modified	when	you	set	them	or	when	you
call	a	configuration	VI	or	function	that	sets	them,	respectively.	It	is
important	to	set	the	properties	or	attributes	or	call	any	configuration	VIs
or	functions	before	reading	back	any	property	or	attribute	values	for	the
following	reasons:

Values	read	are	coerced	depending	on	the	current	configuration	of
the	session.	If	you	read	a	property	or	attribute	value	and	then	set
other	properties	or	attributes,	the	value	read	may	no	longer	be
valid.
The	driver	verifies	that	the	configuration	of	the	device	is	valid	at	the
time	the	property	or	attribute	is	read.	It	is	possible	to	get	an	error
when	reading	a	property	or	attribute	if	the	configuration	is	not	valid
at	that	point,	even	when	a	setting	later	could	make	it	valid.
Reading	properties	or	attributes	causes	the	driver	to	verify	the
current	configuration.	If	you	change	some	of	the	settings	later,
those	settings	need	to	be	validated	again.
Note		Perform	all	module	configuration	before	writing	data	on
output	devices.



Features
This	book	contains	information	about	the	following	power	supply,	SMU,
and	NI-DCPower	features:

Detecting	Internal/Auxiliary	Power
Enabling	the	Output
Measurements
Programming	the	Output
Simulating	a	Power	Supply	or	SMU



Detecting	Internal/Auxiliary	Power
Use	an	auxiliary	power	source	to	enable	the	full-power	capabilities	of
NI	power	supplies	and	SMUs	that	support	this	feature.	NI-DCPower	can
dynamically	query	whether	the	auxiliary	power	is	connected	to	the
device.	The	niDCPower	Auxiliary	Power	Source	Available	property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	returns	TRUE	if	auxiliary	power	is	connected	to	the	device	and
FALSE	if	only	internal	power	is	available	on	the	device.
NI	power	supplies	and	SMUs	cannot	differentiate	between	an	auxiliary
power	loss	or	a	blown	fuse	on	the	auxiliary	power	input	line.	If	auxiliary
power	is	properly	connected	and	the	niDCPower	Auxiliary	Power	Source
Available	property	or	the
NIDCPOWER_ATTR_AUXILIARY_POWER_SOURCE_AVAILABLE
attribute	returns	FALSE,	you	might	need	to	replace	the	auxiliary	power
input	fuse.
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Enabling	the	Output
To	power	on	or	off	the	output	channels,	use	the	niDCPower	Configure
Output	Enabled	VI	or	the	niDCPower_ConfigureOutputEnabled	function.
When	you	enable	an	output,	if	the	selected	output	function	is	DC	Voltage,
the	programmed	voltage	level	and	current	limit	are	applied	to	the
channel.	If	the	selected	output	function	is	DC	Current,	the	programmed
current	level	and	voltage	limit	are	applied	to	the	channel.	When	you
disable	an	output,	the	channel	generates	0	V.
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Measurements
NI	DC	power	supplies	and	SMUs	can	measure	the	current	and	voltage
they	generate.	This	measurement	capability	is	essential	for	many	test
applications	including	I-V	curve	tracing,	where	current	must	be	measured
for	multiple	voltage	set	points,	and	IDDQ	measurements	on	CMOS
integrated	circuits,	where	current	consumption	must	be	characterized	at
fixed	voltage	levels.	For	more	information	about	measurement	resolution,
accuracy,	and	speed,	refer	to	your	device	specifications	document.
To	retrieve	these	measurements,	use	the	niDCPower	Measure	or
niDCPower	Measure	Multiple	VI,	or	the	niDCPower_Measure	or
niDCPower_MeasureMultiple	function.	The	niDCPower	Measure	VI	and	the
niDCPower_Measure	function	measure	either	the	voltage	or	the	current	on
a	single	channel.	The	niDCPower	Measure	Multiple	VI	and	the
niDCPower_MeasureMultiple	function	measure	both	the	voltage	and	the
current	on	multiple	channels.
As	with	any	measurement	device,	there	is	a	trade-off	between	the	speed
at	which	measurements	are	performed	and	the	amount	of	noise	in	those
measurements.	NI	power	supplies	and	SMUs	provide	flexibility	in	this
trade-off	by	averaging	a	configurable	number	of	samples	before	returning
a	measurement.	To	learn	more	about	adjusting	the	number	of
measurement	samples	to	average,	including	the	trade-off	between
measurement	speed	and	measurement	noise,	refer	to	the	Measurement
Averaging	topic	for	your	device.

NIDCPowerVIRef.chm::/niDCPower_Measure.html
NIDCPowerVIRef.chm::/niDCPower_Measure_Multiple.html
NIDCPowerCRef.chm::/cviniDCPower_Measure.html
NIDCPowerCRef.chm::/cviniDCPower_MeasureMultiple.html


Programming	the	Output
NI	DC	power	supplies	or	SMUs	have	two	possible	output	functions:	DC
Voltage	and	DC	Current.	To	force	a	voltage,	set	the	output	function	to
NIDCPOWER_VAL_DC_VOLTAGE	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Voltage	using	the
niDCPower	Configure	Output	Function	VI.	To	force	a	current,	set	the
output	function	to	NIDCPOWER_VAL_DC_CURRENT	using	the
niDCPower_ConfigureOutputFunction	function	or	DC	Current	using	the
niDCPower	Configure	Output	Function	VI.
When	you	select	the	DC	Voltage	output	function,	the	instrument	attempts
to	generate	the	desired	output	voltage	level	as	long	as	the	output	current
is	below	the	current	limit.	You	can	program	the	voltage	level	with	the
niDCPower	Configure	Voltage	Level	VI	or	the
niDCPower_ConfigureVoltageLevel	function.	You	can	program	the	current
limit	with	the	niDCPower	Configure	Current	Limit	VI	or	the
niDCPower_ConfigureCurrentLimit	function.
When	the	DC	Current	output	function	is	selected,	the	instrument	attempts
to	generate	the	desired	output	current	level	as	long	as	the	output	voltage
is	below	the	voltage	limit.	You	can	program	the	current	level	with	the
niDCPower	Configure	Current	Level	VI	or	the
niDCPower_ConfigureCurrentLevel	function.	You	can	program	the	voltage
limit	with	the	niDCPower	Configure	Voltage	Limit	VI	or	the
niDCPower_ConfigureVoltageLimit	function.
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Simulating	a	Power	Supply	or	SMU
Simulate	a	power	supply	or	SMU	using	NI-DCPower	or	Measurement	&
Automation	Explorer	(MAX)	to	develop,	modify,	and/or	test	an	application
without	hardware.	Using	a	simulated	device	to	test	an	application
eliminates	the	risk	of	hardware	damage.	Additionally,	you	can	use	a
simulated	power	supply	or	SMU	to	evaluate	an	NI	product	for	which	you
do	not	have	hardware.

Tip		As	with	any	installed	and	configured	power	supply	or	SMU,
you	can	use	the	NI-DCPower	Soft	Front	Panel	to	test	the	basic
functionality	of	the	device.



NI-DCPower
Complete	the	following	steps	to	create	and	configure	a	simulated	power
supply	or	SMU	using	NI-DCPower.

1.	 Run	the	niDCPower	Initialize	With	Options	VI	or	the
niDCPower_InitWithOptions	function.

2.	 Set	the	option	string	parameter.	The	option	string	parameter	is
composed	of	the	Simulate	and	Driver	Setup	keywords,	as
illustrated	in	the	following	example:	

Simulate=1,	DriverSetup=Model:<model	number>;	BoardType:<type>
The	DriverSetup	keyword	is	set	using	the	driver	setup	string—the
device	model	number	and	board	type.	When	you	specify	the	driver
setup	string,	NI-DCPower	ignores	the	resource	name	parameter.
If	you	do	not	specify	the	driver	setup	string,	NI-DCPower	simulates
the	device	specified	in	the	resource	name	parameter.	If	you
specify	neither	the	driver	setup	string	nor	the	resource	name
parameter,	NI-DCPower	simulates	an	NI	PXI-4110	by	default.

Example
When	simulating	an	NI	PXI-4110,	use	the	following	option	string
parameter:

Simulate=1,	DriverSetup=Model:4110;	BoardType:PXI
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MAX
Complete	the	following	steps	to	create	and	configure	a	simulated	power
supply	in	Measurement	&	Automation	Explorer	(MAX).

1.	 Launch	MAX.
2.	 Right-click	Devices	and	Interfaces	in	the	MAX	configuration	tree,

and	select	Create	New.	The	Create	New	dialog	box	opens.
3.	 Select	NI-DAQmx	Simulated	Device,	and	click	Finish.	The

Choose	Device	dialog	box	opens.
4.	 Expand	Power	Supplies,	and	select	the	power	supply	to

simulate.
5.	 Click	OK.	The	power	supply	appears	in	the	MAX	configuration

tree	with	a	yellow	icon	to	indicate	that	it	is	a	simulated	device.
Refer	to	the	NI-DAQmx	Simulated	Devices	topic	in	the	Measurement	&
Automation	Explorer	Help	for	NI-DAQmx	for	more	detailed	information
about	simulating	NI-DAQmx	devices.



Examples
NI-DCPower	examples	are	instructional	tools	that	demonstrate	power
supply	functionality.	NI-DCPower	examples	are	available	for	the	following
ADEs:

LabVIEW	7.1	or	later
LabWindows/CVI	7.0	or	later
Visual	Basic	6.0

For	example	locations,	refer	to	the	NI-DCPower	Readme.



Operating	System	Support
For	information	about	the	supported	operating	system	(OS)	for	your
device,	refer	to	the	NI-DCPower	Readme.
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Prefixes
Prefix Meaning Value
f femto 10-15

p pico 10-12

n nano 10-9

µ micro 10-6

m milli 10-3

k kilo 103

M mega 106

G giga 109

T tera 1012



Numbers/Symbols
nV nanovolts 10-9	volts

µV microvolts 10-6	volts

µΩ microohms 10-6	ohms

mV millivolts 10-3	volts

mΩ milliohms 10-3	ohms

MΩ megaohms 106	ohms

pA picoamps 10-12	amperes

nA nanoamps 10-9	amperes

µA microamps 10-6	amperes

mA milliamps 10-3	amperes



A
AC alternating	current
ADE application	development	environment—A	software

environment	incorporating	the	development,	debug,	and
analysis	tools	for	software	development.

admittance The	reciprocal	of	impedance.
aperture
time

The	period	during	which	the	ADC	is	reading	the	input
signal.

ATE automated	test	equipment—A	term	typically	applied	to
computer-based	systems	for	testing	semiconductor
components	or	circuit	card	assemblies.

auxiliary
power

Power	drawn	from	a	separate,	external	power	source.	Use
an	auxiliary	power	source	to	increase	the	output	capability
of	a	power	supply	that	is	only	drawing	internal	power.

AWG American	Wire	Gauge—A	U.S.	standard	set	of	non-ferrous
wire	conductor	sizes.	Gauge	means	the	diameter.	Non-
ferrous	includes	copper	and	also	aluminum	and	other
materials,	but	is	most	frequently	applied	to	copper
household	electrical	wiring	and	telephone	wiring.	Typical
household	wiring	is	AWG	number	12	or	14.	Telephone	wire
is	usually	22,	24,	or	26.	The	higher	the	gauge	number,	the
smaller	the	diameter	and	the	thinner	the	wire.	Since	thicker
wire	carries	more	current	because	it	has	less	electrical
resistance	over	a	given	length,	thicker	wire	is	better	for
longer	distances.



B
bandwidth The	range	of	frequencies	present	in	a	signal,	or	the	range

of	frequencies	to	which	a	measuring	device	can	respond.
bipolar A	signal	range	that	includes	both	positive	and	negative

values	(for	example,	-5	V	to	+5	V).



C
calibration The	process	of	determining	the	accuracy	of	an

instrument.	In	a	formal	sense,	calibration	establishes	the
relationship	of	an	instrument's	measurement	to	the	value
provided	by	a	standard.	When	that	relationship	is	known,
the	instrument	can	then	be	adjusted	(calibrated)	for	best
accuracy.

capacitance The	ability	of	a	capacitor	to	store	an	electrical	charge,
measured	in	Farads.

common-
mode	noise

Noise	present	between	the	output	common/ground	and
the	chassis	or	earth	ground.	In	this	sense,	the	equivalent
circuit	is	a	current	noise	source	connected	across	these
two	terminals.

compliance A	channel	that	is	operating	at	the	programmed	limit
because	the	requested	level	cannot	be	reached.

connector A	device	that	provides	electrical	connection.
constant
current
mode

An	NI-DCPower	control	mode	in	which	a	circuit	supplies	a
constant	current	source,	independent	of	the	load	placed
on	the	current	generator.	When	constant	current	mode	is
enabled	on	an	output	channel,	the	current	is	held	constant
at	the	value	specified	by	the	current	limit,	and	the	voltage
rises	or	falls	as	the	load	requires	more	or	less	power.

constant
voltage
mode

An	NI-DCPower	control	mode	in	which	a	circuit	supplies	a
constant	voltage	source.	When	constant	voltage	mode	is
enabled	on	an	output	channel,	the	voltage	is	held
constant	at	the	value	specified	by	the	voltage	level
despite	load	changes.

crowbar
protection

A	method	of	overvoltage	protection	that	shunts	the
auxiliary	power	input	to	ground	if	excessive	voltage	is
detected.	When	crowbar	protection	is	enabled,	a
overvoltage	condition	might	cause	the	auxiliary	power
input	fuse	to	blow.

current The	rate	of	flow	of	electric	charge,	measured	in	amperes.
current
leakage

Error	current	that	travels	through	undesired	paths	and	can
degrade	signals.

current-
resistance
loss

See	voltage	drop.



D
DC direct	current
DC	voltage The	direct	current	(non-changing)	component	of	a

voltage.	In	practice,	the	DC	voltage	should	not	change
over	the	period	of	observation,	that	is,	the	measurement
time.

Delayed
Configuration
mode

An	NI-DCPower	configuration	mode	in	which	every
configuration	call	is	cached	until	the	configuration	is
initiated.

DMM digital	multimeter
driver Software	that	controls	a	specific	hardware	device	such

as	a	DAQ	device	or	GPIB	interface	device.
DSP digital	signal	processor
DUT device	under	test



E
electrical
load

A	device	to	which	power	is	supplied.

EEPROM Electrically	erasable	programmable	read-only	memory.
Read-only	memory	that	you	can	erase	with	an	electrical
signal	and	reprogram.

EMF electromotive	force
EXTCLK Auxiliary	Clock	signal.



F
fall	time The	time	for	a	signal	to	move	from	90%	to	10%	of	the	signal

value.
frequency f—The	basic	unit	of	rate,	measured	in	events	or	oscillations

per	second	using	a	frequency	counter	or	spectrum	analyzer.
Frequency	is	the	reciprocal	of	the	period	of	a	signal.



G
GND ground—A	noncurrent-carrying	circuit	intended	for	safety.



H
handle A	unique	variable	you	use	to	refer	to	a	window	or	other

interface	element	in	C	programming.
Hz hertz.	Cycles	per	second.	See	frequency



I
Immediate
mode

An	NI-DCPower	configuration	mode	in	which	every
configuration	call	is	immediately	applied	to	the	device.

impedance The	property	of	a	circuit	or	circuit	element	to	resist	both
steady-state	current	flow	(resistance)	and	changes	in
current	or	voltage	(reactance).

inductance The	property	of	a	circuit	or	circuit	element	to	oppose	a
change	in	current	flow,	thus	causing	current	changes	to	lag
behind	voltage	changes.	Inductance	is	measured	in	henrys
(H).

inductive
load

A	load	whose	current	changes	lag	behind	its	voltage
changes.	See	inductance.

instrument
driver

A	set	of	high-level	functions	that	control	and	communicate
with	instrument	hardware	in	a	system.

internal
power

For	NI	DC	power	supplies,	power	drawn	from	the	PXI
chassis	backplane.

inverse
voltage
protection

A	protection	circuit	that	prevents	the	power	supply	from
being	damaged	in	the	event	that	an	inverse	voltage	is
applied	at	the	input	or	output	terminals.

I/O input/output
isolation Describes	the	electrical	separation	between	the	input	and

the	output,	measured	in	resistance.
isolated
output

An	output	that	is	electrically	separated	from	the	input.

IVI Interchangeable	Virtual	Instruments.	A	software	standard
for	creating	a	common	interface	(API)	to	common	test	and
measurement	instruments.

IVI	driver A	driver	written	according	to	the	IVI	specification.	The
generic	driver	for	a	class	of	instruments	(such	as
voltmeters)	is	called	a	class	driver,	whereas	the	driver	for	a
specific	instrument	from	a	specific	manufacturer	is	called	a
device-specific	driver.



L
LabVIEW Laboratory	Virtual	Instrument	Engineering	Workbench.

LabVIEW	is	a	graphical	programming	language	that	uses
icons	instead	of	lines	of	text	to	create	programs.

leakage
current

Error	current	that	travels	through	undesired	paths	that	can
degrade	signals.

LED light	emitting	diode—A	semiconductor	light	source.
line
regulation

The	ability	of	the	power	supply	to	maintain	its	output	voltage
given	changes	in	the	input	line	voltage.	Line	regulation	is
expressed	as	percent	of	change	in	the	output	voltage
relative	to	the	change	in	the	input	line	voltage.	For	NI	DC
power	supplies,	the	line	regulation	specification	refers	to	the
auxiliary	power	input.

load See	electrical	load.
load
regulation

The	ability	of	an	output	channel	to	remain	constant	given
changes	in	the	load.	The	control	mode	enabled	on	the
output	channel	determines	the	way	in	which	load	regulation
is	expressed.



M
max maximum
Measurement	&
Automation
Explorer

The	standard	National	Instruments	hardware
configuration	and	diagnostic	environment	on
Windows.

min minutes	or	minimum



N
NaN Not	a	Number—Digital	display	value	for	a	floating-point

representation	of	<Not	A	Number>.	Typically	the	result	of	an
undefined	operation,	such	as	log(–1).

noise Analog.	Unwanted	signals.	Noise	comes	from	both	external
and	internal	sources.	Noise	corrupts	signals	you	are	trying	to
send	or	receive.

normal-
mode
noise

Noise	present	between	the	output	HI	and	output	LO/ground,
appearing	either	in	series	(constant	voltage	mode)	or	parallel
(constant	current	mode)	with	the	output.	Normal-mode	noise
can	be	expressed	as	voltage	noise	or	current	noise,
depending	on	the	control	mode	of	the	output	channel.



O
output	HI The	output	channel	terminal	capable	of	supplying	a	DC

potential.
output	LO The	output	channel	terminal	referenced	to	circuit	common.
overcurrent
protection

A	power	supply	protection	circuit	that	limits	the	output
current	in	the	event	of	an	overcurrent	condition.

overvoltage
protection

A	power	supply	protection	circuit	that	either	shuts	down	or
crowbars	the	power	supply	in	the	event	of	an	overvoltage
condition.

OVP overvoltage	protection



P
ppm parts	per	million
preload A	small	amount	of	current	drawn	from	a	power	supply

used	stabilize	its	operation.
programmable
power	supply

An	instrument	providing	user-adjustable	power
(voltage	and	current)	for	a	DUT.

pulse	load A	load	whose	current	amplitude	deviates	from	its
steady	state	value	for	short	periods	of	time.

PXI PCI	eXtensions	for	Instrumentation.	A	modular,
computer-based	instrumentation	platform.



R
reactance The	property	of	a	circuit	or	circuit	element	to	resist	changes

in	voltage	or	current.
remote
sensing

A	method	of	monitoring	the	output	voltage	directly	at	the
load	rather	than	at	the	power	supply	output	terminals.
Remote	sensing	improves	regulation	when	in	voltage
mode.

resistance The	property	of	a	material	to	resist	or	inhibit	current	flow.
resonance The	frequency	at	which	capacitive	reactance	and	inductive

reactance	are	equal	and,	thus,	cancel	one	another's
effects.

response
time

The	time	a	device	takes	to	respond	to	a	request.

ringing A	decaying	sinusoidal	signal	resulting	from	an	external
perturbation	(for	example,	a	transient	load,	an	application	of
a	capacitive	discharge,	etc).

ripple The	level	of	the	undesired	frequency	components	on	a	DC
power	supply	output.	The	ripple	is	most	often	the	same
frequency	as	the	AC	input	voltage	or	the	internal	switching
frequency.	This	is	measured	using	a	spectrum	analysis.

rise	time The	time	for	a	signal	to	transition	from	10%	to	90%	of	the
maximum	signal	amplitude.

rms root	mean	square



S
settling
time

The	time	required	for	a	circuit	to	reach	a	stable	mode	of
operation.

shunt An	electronic	component	that	diverts	current.
shunt
resistance

A	resistor	connected	in	parallel	or	in	shunt	with	a	circuit	or
other	component.

sink A	device	that	can	dissipate	power.
sinking The	ability	to	dissipate	power	from	active	circuitry.
sinusoidal
signal

A	signal	varying	in	proportion	to	the	sine	of	an	angle	or	time
function.

slew	rate The	voltage	rate	of	change	as	a	function	of	time.	Slew	rate
limitations	are	first	seen	as	distortion	at	higher	signal
frequencies.

SMU source-measure	unit.	A	device	capable	of	sourcing	and
measuring	DC	voltage	and	current	with	high	precision.

source A	device	that	can	supply	power	to	an	external	device.
sourcing The	ability	to	supply	power	for	external	circuitry.



T
tempco temperature	coefficient.	Describes	how	much	a	property

changes	with	temperature.
thermal
protection

A	power	supply	protection	circuit	that	shuts	down	the	power
supply	in	the	event	of	an	overtemperature	condition.

thermistor Semiconductor	sensor	that	exhibits	a	repeatable	change	in
electrical	resistance	as	a	function	of	temperature;	most
thermistors	exhibit	a	negative	temperature	coefficient.

time
constant

A	figure	of	merit	for	system	speed.

transient
response

The	length	of	time	it	takes	for	a	circuit	to	recover	from	a
sudden	change	in	an	output	load	or	an	input	voltage.



U
uncertainty The	total	calculated	error	caused	by	calibration	error,

noise,	nonlinearity,	offsets,	temperature	drift,	and	so	on.
unregulated
mode

Describes	the	state	of	an	output	channel	that	has	neither
constant	voltage	mode	or	constant	current	mode	enabled.



V
V Volts.
VAC Volts,	Alternating	Current.
VDC Volts,	Direct	Current.
VI Virtual	Instrument—Program	in	LabVIEW	that	models

the	appearance	and	function	of	a	physical	instrument.
voltage	drop The	decrease	in	voltage	along	a	conductor.	The

amount	of	voltage	drop	is	dependant	on	the
conductor	(wire	gauge	and	length)	and	the	amount	of
current	flowing	through	the	conductor.

VXI VME	eXtensions	for	Instrumentation	(bus)
VXIplug&play
SystemsAlliance

A	group	of	VXI	developers	dedicated	to	making	VXI
devices	as	easy	to	use	as	possible,	primarily	by
simplifying	software	development.



W
wideband
noise

The	maximum	amount	of	microprocessor	and	power	supply
noise	that	may	be	present	on	the	output	voltage.



Important	Information
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
The	NI	PXI-4110	and	the	NI	PXI-4130	are	warranted	against	defects	in
materials	and	workmanship	for	a	period	of	1	year	from	the	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	equipment	that	proves	to
be	defective	during	the	warranty	period.	This	warranty	includes	parts	and
labor.
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL



INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING
FROM	LOSS	OF	DATA,	PROFITS,	USE	OF	PRODUCTS,	OR
INCIDENTAL	OR	CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF
THE	POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action
accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of	others,	and	we
ask	our	users	to	do	the	same.	NI	software	is	protected	by	copyright	and
other	intellectual	property	laws.	Where	NI	software	may	be	used	to
reproduce	software	or	other	materials	belonging	to	others,	you	may	use
NI	software	only	to	reproduce	materials	that	you	may	reproduce	in
accordance	with	the	terms	of	any	applicable	license	or	other	legal
restriction.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,
Stateflow®,	and	xPC	TargetBox®	are	registered	trademarks,	and
TargetBox™	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.

javascript:WWW(WWW_Trademark)


Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	CD,	or	ni.com/patents.

javascript:WWW(WWW_Patents)


WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED
WITH	COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,
INSTALLATION	ERRORS,	SOFTWARE	AND	HARDWARE
COMPATIBILITY	PROBLEMS,	MALFUNCTIONS	OR	FAILURES	OF
ELECTRONIC	MONITORING	OR	CONTROL	DEVICES,	TRANSIENT
FAILURES	OF	ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR	ERRORS	ON
THE	PART	OF	THE	USER	OR	APPLICATIONS	DESIGNER	(ADVERSE
FACTORS	SUCH	AS	THESE	ARE	HEREAFTER	COLLECTIVELY
TERMED	"SYSTEM	FAILURES").	ANY	APPLICATION	WHERE	A
SYSTEM	FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO
PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY
INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON	ONE
FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF	SYSTEM
FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE	USER	OR
APPLICATION	DESIGNER	MUST	TAKE	REASONABLY	PRUDENT
STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT
NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING	PLATFORMS
AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER	MAY	USE
NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION	WITH
OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR
CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR



APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR
APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site	at	ni.com
for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at	ni.com/support
include	the	following:

Self-Help	Resources—For	answers	and	solutions,	visit	the
award-winning	National	Instruments	Web	site	for	software
drivers	and	updates,	a	searchable	KnowledgeBase,	product
manuals,	step-by-step	troubleshooting	wizards,	thousands	of
example	programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users	receive	free
Basic	Service,	which	includes	access	to	hundreds	of
Applications	Engineers	worldwide	in	the	NI	Discussion
Forums	at	ni.com/forums.	National	Instruments	Applications
Engineers	make	sure	every	question	receives	an	answer.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.
Declaration	of	Conformity	(DoC)—A	DoC	is	our	claim	of
compliance	with	the	Council	of	the	European	Communities	using
the	manufacturers	declaration	of	conformity.	This	system	affords
the	user	protection	for	electronic	compatibility	(EMC)	and	product
safety.	You	can	obtain	the	DoC	for	your	product	by	visiting
ni.com/certification.
Calibration	Certificate—If	your	product	supports	calibration,	you
can	obtain	the	calibration	certificate	for	your	product	at
ni.com/calibration.
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If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	662	457990-0
Belgium 32	(0)	2	757	0020
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	6555	7838
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 385	(0)	9	725	72511
France 33	(0)	1	48	14	24	24
Germany 49	89	7413130
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	413091
Japan 81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	(0)	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	(0)	348	433	466
New	Zealand 0800	553	322
Norway 47	(0)	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210
Russia 7	495	783	6851
Singapore 1800	226	5886
Slovenia 386	3	425	42	00



South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	(0)	8	587	895	00
Switzerland 41	56	2005151
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	(0)	1635	523545
United	States	(Corporate) 512	683	0100
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